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Notice
While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.
Documentation disclaimer
“Documentation” means information published by Avaya in varying
mediums which may include product information, operating
instructions and performance specifications that Avaya may generally
make available to users of its products and Hosted Services.
Documentation does not include marketing materials. Avaya shall not
be responsible for any modifications, additions, or deletions to the
original published version of documentation unless such
modifications, additions, or deletions were performed by Avaya. End
User agrees to indemnify and hold harmless Avaya, Avaya's agents,
servants and employees against all claims, lawsuits, demands and
judgments arising out of, or in connection with, subsequent
modifications, additions or deletions to this documentation, to the
extent made by End User.
Link disclaimer
Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.
Warranty
Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: http://support.avaya.com/helpcenter/
getGenericDetails?detailId=C20091120112456651010 under the link
“Warranty & Product Lifecycle” or such successor site as designated
by Avaya. Please note that if You acquired the product(s) from an
authorized Avaya Channel Partner outside of the United States and
Canada, the warranty is provided to You by said Avaya Channel
Partner and not by Avaya.
“Hosted Service” means a hosted service subscription that You
acquire from either Avaya or an authorized Avaya Channel Partner
(as applicable) and which is described further in Hosted SAS or other
service description documentation regarding the applicable hosted
service. If You purchase a Hosted Service subscription, the foregoing
limited warranty may not apply but You may be entitled to support
services in connection with the Hosted Service as described further
in your service description documents for the applicable Hosted
Service. Contact Avaya or Avaya Channel Partner (as applicable) for
more information.
Hosted Service
THE FOLLOWING APPLIES IF YOU PURCHASE A HOSTED
SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA CHANNEL
PARTNER (AS APPLICABLE), THE TERMS OF USE FOR HOSTED
SERVICES ARE AVAILABLE ON THE AVAYA WEBSITE, HTTP://
SUPPORT.AVAYA.COM/LICENSEINFO UNDER THE LINK “Avaya
Terms of Use for Hosted Services” OR SUCH SUCCESSOR SITE
AS DESIGNATED BY AVAYA, AND ARE APPLICABLE TO ANYONE
WHO ACCESSES OR USES THE HOSTED SERVICE. BY
ACCESSING OR USING THE HOSTED SERVICE, OR
AUTHORIZING OTHERS TO DO SO, YOU, ON BEHALF OF
YOURSELF AND THE ENTITY FOR WHOM YOU ARE DOING SO
(HEREINAFTER REFERRED TO INTERCHANGEABLY AS “YOU”
AND “END USER”), AGREE TO THE TERMS OF USE. IF YOU ARE
ACCEPTING THE TERMS OF USE ON BEHALF A COMPANY OR
OTHER LEGAL ENTITY, YOU REPRESENT THAT YOU HAVE THE
AUTHORITY TO BIND SUCH ENTITY TO THESE TERMS OF USE.

IF YOU DO NOT HAVE SUCH AUTHORITY, OR IF YOU DO NOT
WISH TO ACCEPT THESE TERMS OF USE, YOU MUST NOT
ACCESS OR USE THE HOSTED SERVICE OR AUTHORIZE
ANYONE TO ACCESS OR USE THE HOSTED SERVICE. YOUR
USE OF THE HOSTED SERVICE SHALL BE LIMITED BY THE
NUMBER AND TYPE OF LICENSES PURCHASED UNDER YOUR
CONTRACT FOR THE HOSTED SERVICE, PROVIDED,
HOWEVER, THAT FOR CERTAIN HOSTED SERVICES IF
APPLICABLE, YOU MAY HAVE THE OPPORTUNITY TO USE FLEX
LICENSES, WHICH WILL BE INVOICED ACCORDING TO ACTUAL
USAGE ABOVE THE CONTRACT LICENSE LEVEL. CONTACT
AVAYA OR AVAYA’S CHANNEL PARTNER FOR MORE
INFORMATION ABOUT THE LICENSES FOR THE APPLICABLE
HOSTED SERVICE, THE AVAILABILITY OF ANY FLEX LICENSES
(IF APPLICABLE), PRICING AND BILLING INFORMATION, AND
OTHER IMPORTANT INFORMATION REGARDING THE HOSTED
SERVICE.
Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTP://SUPPORT.AVAYA.COM/LICENSEINFO, UNDER
THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya Products)”
OR SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, ARE
APPLICABLE TO ANYONE WHO DOWNLOADS, USES AND/OR
INSTALLS AVAYA SOFTWARE, PURCHASED FROM AVAYA INC.,
ANY AVAYA AFFILIATE, OR AN AVAYA CHANNEL PARTNER (AS
APPLICABLE) UNDER A COMMERCIAL AGREEMENT WITH
AVAYA OR AN AVAYA CHANNEL PARTNER. UNLESS OTHERWISE
AGREED TO BY AVAYA IN WRITING, AVAYA DOES NOT EXTEND
THIS LICENSE IF THE SOFTWARE WAS OBTAINED FROM
ANYONE OTHER THAN AVAYA, AN AVAYA AFFILIATE OR AN
AVAYA CHANNEL PARTNER; AVAYA RESERVES THE RIGHT TO
TAKE LEGAL ACTION AGAINST YOU AND ANYONE ELSE USING
OR SELLING THE SOFTWARE WITHOUT A LICENSE. BY
INSTALLING, DOWNLOADING OR USING THE SOFTWARE, OR
AUTHORIZING OTHERS TO DO SO, YOU, ON BEHALF OF
YOURSELF AND THE ENTITY FOR WHOM YOU ARE
INSTALLING, DOWNLOADING OR USING THE SOFTWARE
(HEREINAFTER REFERRED TO INTERCHANGEABLY AS “YOU”
AND “END USER”), AGREE TO THESE TERMS AND CONDITIONS
AND CREATE A BINDING CONTRACT BETWEEN YOU AND
AVAYA INC. OR THE APPLICABLE AVAYA AFFILIATE (“AVAYA”).
Avaya grants You a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License. The
applicable number of licenses and units of capacity for which the
license is granted will be one (1), unless a different number of
licenses or units of capacity is specified in the documentation or other
materials available to You. “Software” means computer programs in
object code, provided by Avaya or an Avaya Channel Partner,
whether as stand-alone products, pre-installed on hardware products,
and any upgrades, updates, patches, bug fixes, or modified versions
thereto. “Designated Processor” means a single stand-alone
computing device. “Server” means a Designated Processor that
hosts a software application to be accessed by multiple users.
“Instance” means a single copy of the Software executing at a
particular time: (i) on one physical machine; or (ii) on one deployed
software virtual machine (“VM”) or similar deployment.
License types
Designated System(s) License (DS). End User may install and use
each copy or an Instance of the Software only on a number of
Designated Processors up to the number indicated in the order.
Avaya may require the Designated Processor(s) to be identified in
the order by type, serial number, feature key, Instance, location or
other specific designation, or to be provided by End User to Avaya
through electronic means established by Avaya specifically for this
purpose.
Concurrent User License (CU). End User may install and use the
Software on multiple Designated Processors or one or more Servers,
so long as only the licensed number of Units are accessing and using
the Software at any given time. A “Unit” means the unit on which
Avaya, at its sole discretion, bases the pricing of its licenses and can
be, without limitation, an agent, port or user, an e-mail or voice mail
account in the name of a person or corporate function (e.g.,
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webmaster or helpdesk), or a directory entry in the administrative
database utilized by the Software that permits one user to interface
with the Software. Units may be linked to a specific, identified Server
or an Instance of the Software.
Database License (DL). End User may install and use each copy or
an Instance of the Software on one Server or on multiple Servers
provided that each of the Servers on which the Software is installed
communicates with no more than one Instance of the same
database.
CPU License (CP). End User may install and use each copy or
Instance of the Software on a number of Servers up to the number
indicated in the order provided that the performance capacity of the
Server(s) does not exceed the performance capacity specified for the
Software. End User may not re-install or operate the Software on
Server(s) with a larger performance capacity without Avaya’s prior
consent and payment of an upgrade fee.
Named User License (NU). You may: (i) install and use each copy or
Instance of the Software on a single Designated Processor or Server
per authorized Named User (defined below); or (ii) install and use
each copy or Instance of the Software on a Server so long as only
authorized Named Users access and use the Software. “Named
User”, means a user or device that has been expressly authorized by
Avaya to access and use the Software. At Avaya’s sole discretion, a
“Named User” may be, without limitation, designated by name,
corporate function (e.g., webmaster or helpdesk), an e-mail or voice
mail account in the name of a person or corporate function, or a
directory entry in the administrative database utilized by the Software
that permits one user to interface with the Software.
Shrinkwrap License (SR). You may install and use the Software in
accordance with the terms and conditions of the applicable license
agreements, such as “shrinkwrap” or “clickthrough” license
accompanying or applicable to the Software (“Shrinkwrap License”).
Heritage Nortel Software
“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
Business in December 2009. The Heritage Nortel Software is the
software contained within the list of Heritage Nortel Products located
at http://support.avaya.com/LicenseInfo under the link “Heritage
Nortel Products” or such successor site as designated by Avaya. For
Heritage Nortel Software, Avaya grants Customer a license to use
Heritage Nortel Software provided hereunder solely to the extent of
the authorized activation or authorized usage level, solely for the
purpose specified in the Documentation, and solely as embedded in,
for execution on, or for communication with Avaya equipment.
Charges for Heritage Nortel Software may be based on extent of
activation or use authorized as specified in an order or invoice.
Copyright
Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.
Virtualization
The following applies if the product is deployed on a virtual machine.
Each product has its own ordering code and license types. Note that
each Instance of a product must be separately licensed and ordered.
For example, if the end user customer or Avaya Channel Partner
would like to install two Instances of the same type of products, then
two products of that type must be ordered.
Third Party Components
“Third Party Components” mean certain software programs or
portions thereof included in the Software or Hosted Service may
contain software (including open source software) distributed under

third party agreements (“Third Party Components”), which contain
terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed
Linux OS source code (for those products that have distributed Linux
OS source code) and identifying the copyright holders of the Third
Party Components and the Third Party Terms that apply is available
in the products, Documentation or on Avaya’s website at: http://
support.avaya.com/Copyright or such successor site as designated
by Avaya. The open source software license terms provided as Third
Party Terms are consistent with the license rights granted in these
Software License Terms, and may contain additional rights benefiting
You, such as modification and distribution of the open source
software. The Third Party Terms shall take precedence over these
Software License Terms, solely with respect to the applicable Third
Party Components to the extent that these Software License Terms
impose greater restrictions on You than the applicable Third Party
Terms.
The following applies if the H.264 (AVC) codec is distributed with the
product. THIS PRODUCT IS LICENSED UNDER THE AVC PATENT
PORTFOLIO LICENSE FOR THE PERSONAL USE OF A
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS
GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA,
L.L.C. SEE HTTP://WWW.MPEGLA.COM.
Service Provider
THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS OR SERVICES. THE PRODUCT
OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS
SUBJECT TO THIRD PARTY TERMS AND REQUIRE A SERVICE
PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY FROM
THE THIRD PARTY SUPPLIER. AN AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS MUST BE AUTHORIZED IN
WRITING BY AVAYA AND IF THOSE HOSTED PRODUCTS USE
OR EMBED CERTAIN THIRD PARTY SOFTWARE, INCLUDING
BUT NOT LIMITED TO MICROSOFT SOFTWARE OR CODECS,
THE AVAYA CHANNEL PARTNER IS REQUIRED TO
INDEPENDENTLY OBTAIN ANY APPLICABLE LICENSE
AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S EXPENSE,
DIRECTLY FROM THE APPLICABLE THIRD PARTY SUPPLIER.
WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR EMBED
THE G.729 CODEC, H.264 CODEC, OR H.265 CODEC, THE
AVAYA CHANNEL PARTNER ACKNOWLEDGES AND AGREES
THE AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY
AND ALL RELATED FEES AND/OR ROYALTIES. THE G.729
CODEC IS LICENSED BY SIPRO LAB TELECOM INC. SEE 
WWW.SIPRO.COM/CONTACT.HTML. THE H.264 (AVC) CODEC IS
LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR
THE PERSONAL USE OF A CONSUMER OR OTHER USES IN
WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I) ENCODE
VIDEO IN COMPLIANCE WITH THE AVC STANDARD (“AVC
VIDEO”) AND/OR (II) DECODE AVC VIDEO THAT WAS ENCODED
BY A CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR
WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO
PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE
IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION
FOR H.264 (AVC) AND H.265 (HEVC) CODECS MAY BE
OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.
Compliance with Laws
Customer acknowledges and agrees that it is responsible for
complying with any applicable laws and regulations, including, but not
limited to laws and regulations related to call recording, data privacy,
intellectual property, trade secret, fraud, and music performance
rights, in the country or territory where the Avaya product is used.
Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
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company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.
Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United
States and Canada. For additional support telephone numbers, see
the Avaya Support website: http://support.avaya.com or such
successor site as designated by Avaya.
Security Vulnerabilities
Information about Avaya’s security support policies can be found in
the Security Policies and Support section of https://
support.avaya.com/security.
Suspected Avaya product security vulnerabilities are handled per the
Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).
Downloading Documentation
For the most current versions of Documentation, see the Avaya
Support website: http://support.avaya.com, or such successor site as
designated by Avaya.
Contact Avaya Support
See the Avaya Support website: http://support.avaya.com for product
or Hosted Service notices and articles, or to report a problem with
your Avaya product or Hosted Service. For a list of support telephone
numbers and contact addresses, go to the Avaya Support website: 
http://support.avaya.com (or such successor site as designated by
Avaya), scroll to the bottom of the page, and select Contact Avaya
Support.
Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, or other third parties. Users are not permitted to use such
Marks without prior written consent from Avaya or such third party
which may own the Mark. Nothing contained in this site, the
Documentation, Hosted Service(s) and product(s) should be
construed as granting, by implication, estoppel, or otherwise, any
license or right in and to the Marks without the express written
permission of Avaya or the applicable third party.
Avaya is a registered trademark of Avaya Inc.
All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.
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Chapter 1: Introduction

About this guide
This Using Avaya one-X® Communicator guide describes how to configure and use Avaya one-X®

Communicator.

This guide refers to other Avaya products in the context of how they integrate with Avaya one-X®

Communicator. You can get detailed information about these products from the Avaya Web site at 
http://www.avaya.com/support.

Related documents
Additional documentation includes:

• Avaya one-X® Communicator Overview and Planning

• Implementing one-X® Communicator

• Administering Avaya one-X® Communicator

• Avaya one-X® Communicator Quick Start Guide

• Avaya one-X® Communicator Centralized Administration Tool Guide

• Avaya one-X® Communicator Online Help (Integrated with the application)

To obtain these documents and documents about other Avaya products mentioned in this guide, see
the Avaya Web site at http://www.avaya.com/support.

Accessing Online Help
Procedure

1. Click the Menu icon on the Avaya one-X® Communicator user interface.

2. Select Help Contents.

Alternatively, press the F1 key on your computer keyboard when the application is in focus.
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Supported languages
Avaya one-X® Communicator user interface and user documents are available in the following
languages:

• English

• Chinese, Simplified

• Dutch

• French, Parisian

• German

• Italian

• Japanese

• Korean

• Portuguese, Brazilian

• Russian

• Spanish, Latin American

Supported languages
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Chapter 2: Getting started

Overview
Avaya one-X® Communicator is an intuitive, easy-to-use voice and video softphone that supports
both H.323 and SIP protocols. Avaya one-X® Communicator provides you all your desk phone
features, video, access to enterprise directory, access to your contacts, instant messaging, and
presence in a single interface on your Windows computer. Using Avaya one-X® Communicator, you
can log into your organization server remotely, and make and handle calls from your extension.

Depending on the Avaya one-X® Communicator features installed on your computer, you can:
• Use Avaya one-X Communicator with Avaya one-X Client Enablement Services on page 26
• Make conference calls on page 82
• Use bridge conferencing on page 85
• Use contacts on page 93
• Use call log on page 107
• Use instant messaging on page 112
• Use voice messaging on page 119
• Use visual voice mail on page 122
• Using video with Avaya one-X Communicator on page 72

Logging in to the server
Procedure

1. Start Avaya one-X® Communicator to view the Avaya one-X® Communicator Login dialog
box.

2. Perform one of the following:

• If Avaya one-X® Communicator is integrated with Avaya one-X® Client Enablement
Services, in the User name field, enter your user name on the server.

• If Avaya one-X® Communicator is not integrated with Avaya one-X® Client Enablement
Services, in the Extension field, enter your extension.

3. In the Password box, enter your password.
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4. Select a Login mode for placing and receiving calls from the drop-down menu.

5. Click Log In.

Next steps
Note:
If the connection to the server is lost when you are on an active call, Avaya one-X®

Communicator displays a warning message. You can cancel the recovery, and try to log in
again.

Logging out
Procedure

1. To log out, click the Menu icon.

Avaya one-X® Communicator displays the menu options.

2. Click Log Off.
Next steps
To close Avaya one-X® Communicator: perform either of the following:

• Click the Menu icon and select Exit.
• Right-click the Avaya one-X® Communicator icon on the taskbar, and select Close window.

.

Avaya one-X® Communicator icon descriptions
Icon location Icon Icon name Icon description
Top Bar Icons Menu Opens the menu.

Show Contacts (Toggle) Opens or closes the Contacts pane.

Show Call Log (Toggle) Opens or closes the Call Log pane.

Speaker Phone (Toggle) Opens or closes the settings for audio
devices.

Changes headset mode to
speakerphone mode and vice versa.

Configuration
Panel icons

Mode settings Opens the Mode settings configuration
panel.

Table continues…

Logging out
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Icon location Icon Icon name Icon description
Video settings Opens the Video settings configuration

panel.
Sound settings Opens the Sound settings configuration

panel.
Dial Bar Icons Search Starts searching for a contact.

Place Call Dials a number.

Redial Redials the last dialled number.

Show Dialpad (Toggle) Opens or closes the dial pad.

System Tray
Icons

Avaya one-X®
Communicator icon in the
system tray

Opens, resets, exits, and displays Avaya
one-X® Communicator.

Contacts
Icons

Call (from contacts) Dials the selected number from the
contacts pane.

Call Indicates that the presence of the contact
is unavailable because the contact is not
your favorite contact.

Call Indicates that the favorite contact might
be unavailable for a call.

The contact status is displayed as away,
busy, do not disturb, or on a call.

Call Indicates that the favorite contact is
unavailable for a call on Avaya one-X®

Communicator but available on other
devices.

Email (from contacts) Opens the default email client.

Launch IM Opens the instant messaging window for
the selected contact.

Launch IM Indicates that the presence of the contact
is unavailable because the contact is not
your favorite contact.

Launch IM Indicates that the favorite contact might
be unavailable for an IM conversation.

The contact status is displayed as away,
busy, do not disturb, or on a call.

Launch IM Indicates that the favorite contact is
unavailable on Avaya one-X®

Communicator but available on other
devices.

Table continues…
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Icon location Icon Icon name Icon description
Video Call Starts a video call with the selected

number from the contacts pane.
Video Call Indicates that the presence of the contact

is unavailable because the contact is not
your favorite contact.

Video Call Indicates that the favorite contact might
be unavailable for a video call.

The contact status is displayed as away,
busy, do not disturb, or on a call.

Video Call Indicates that the favorite contact is
unavailable for a video call on Avaya
one-X® Communicator but available on
other devices.

Call Log Icons Call (from Call Log) Dials the selected number from the call
log pane.

Show Contact Details Shows details for the selected contact.

Incoming Call
Icons

Call Answer Answers an incoming call.

Call Ignore Rejects an incoming call.

Outgoing Call
Icons

Transfer call Transfers an ongoing call to another
telephone number.

Hold Places the current call on hold.

Hang Up Ends an ongoing call.

Mute Mutes the audio.

Unmute Starts the audio.

Ongoing Call Places the current call on hold and dials
another number.

Call Resume Resumes the on-hold call.

Voicemail and
Visual
Voicemail
Icons

Voice Mail (Toggle) Notifies and gives access to new voice
mails.

Visual Voice Mail
Messages

Notifies and provides access to new
visual voice mails.

Bridge
Conference
Icons

Bridge Conference Opens the Bridge Conference window.

Lock Bridge Conference Locks the current bridge conference.

Unlock Bridge
Conference

Unlocks the current bridge conference.

Table continues…
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Icon location Icon Icon name Icon description
Add Party to Bridge
Conference

Adds a new participant to bridge
conference.

Mute Bridge Conference Enables the lecture mode.

Unmute Bridge
Conference

Disables the lecture mode.

Instant
Messaging
Window Icons

Emoticons Opens the Emoticons list.

Send attachment Opens the Select Files To Send dialog
box.

Email Opens the default mail client.

Font Displays a font selection window.

Video Window
Icons

Video Opens the Video window.

Mute Video Stops temporarily sending the video
during a call.

Unmute Video Resumes sending video to the other
party.

Stop Video Stops the video but continues the call
only in audio mode.

Video Optimal Size Displays the video in its optimal size.

Full Screen Video Opens the full screen video.

Welcome dialog box
Enables you to choose the login mode and call controls you want to use for your Avaya one-X®

Communicator.

Setting Name Description
Your current mode setting and call controls area This field displays the following information:

• Your extension or login id on the server

• Your current login mode. (This is the Change your
login mode button.)

• Your custom message (if you are integrated with
Avaya one-X® Client Enablement Services)

To change your login mode, click the Change your
login mode button. You can select one of the
following modes:

• Office
Table continues…
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Setting Name Description
• Home

• Mobile

• Traveling
Place and receive call using Use this field to specify the endpoint from which you

want to make and receive calls. Your choices are:

• This Computer (Road Warrior mode)

Use this mode when you are out of office (for
example, traveling). In this mode you can use the
full feature set of the telephony system of your
company from temporary locations anywhere in the
world. This mode is configured for Voice over IP
(VoIP). You can place and handle calls through the
Avaya one-X® Communicator user interface, and
use a headset connected to your computer (or the
computer's microphone and speakers) to speak
and listen.

• Desk Phone (Shared Control mode)

Use this mode when you are at the office. In this
mode you can log into the server and control your
Avaya telephone from Avaya one-X®

Communicator. You can make and handle calls
from Avaya one-X® Communicator user interface
and your Avaya telephone. You can use your
Avaya telephone to speak and listen

• Other Phone (Telecommuter mode)

Use this mode when you are telecommuting (for
example, working from your home office or other
off-site location). You can use this mode to get
features of your telephone system from a location
other than your office. You can place and handle
calls through the Avaya one-X® Communicator
user interface, and you can use a separate
telephone line at your remote location to speak and
listen. Unlike This Computer mode, this mode is
configured for toll-quality audio and optimizes
audio through the other phone. To use this mode,
you must have a separate telephone line available
at your remote location.

Note:

To be able to select another telephone
number, you must specify that number using
the Specify Other button. Avaya one-X®

Communicator does not support some of the
Table continues…

Welcome dialog box
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Setting Name Description

(Avaya SIP Telephony) AST features in the
Other Phone mode. However, you can use
Avaya one-X® Communicator for making and
receiving calls, and for handling mid-call
controls.

Specify Other Use this field to specify a device or a telephone
number on which you want to make and receive
calls.

Login and save settings Use this field to save the login mode and call control
settings and log into the server. The next time you try
to log into the server, Avaya one-X® Communicator
displays the saved settings.

One-time login Use this field to log into the server using the current
login mode and call control settings. However, Avaya
one-X® Communicator does not save these settings
for the next time you try to log into the server.

Configuration Panel
The Configuration Panel appears in Avaya one-X® Communicator user interface on the right and
provides three configuration icons: Mode setting, Video setting, and Sound settings.

Mode settings
Use the Mode settings icon to see the current call settings of Avaya one-X® Communicator:

• Selected Avaya one-X® Communicator user mode
• The Ring also feature settings
• The Block calls feature settings

Video settings
Use the Video settings icon to select the preferred camera and to open the Avaya one-X®

Communicator video window.

Sound settings
Use the Sound settings icon to configure the volume settings and to select audio microphone and
speaker devices for calls in Avaya one-X® Communicator.

Related links
Configuring an user mode on page 19
Selecting a device for ringing on page 19
Selecting a preferred camera for video calls on page 19
Selecting sound devices on page 20
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Configuring an user mode
About this task
Use the mode settings to specify the endpoint from which you want to make and receive calls.

Procedure
1. In the Avaya one-X® Communicator window, click the Mode settings icon.

2. Select the required mode from the Using drop-down menu. Refer to Welcome dialog box  on
page 16 for more information about Avaya one-X® Communicator modes.

3. If you change the mode, log out from Avaya one-X® Communicator and log in again.

Related links
Configuration Panel on page 18

Selecting a device for ringing
About this task
Use the mode settings to specify the endpoint which you want to ring when incoming calls.

Note:
The ring also feature is available only when Avaya one-X® Communicator is integrated with
Avaya one-X® Client Enablement Services

Procedure
1. In the Avaya one-X® Communicator window, click the Mode settings icon.

2. Select the required device from the Ring also drop-down menu.

Related links
Configuration Panel on page 18

Selecting a preferred camera for video calls
About this task
Use the video settings to specify the camera for your video calls.

Procedure
1. In the Avaya one-X® Communicator main window, click the Video settings icon.

2. Select a camera from the Preferred Camera drop-down menu.

Related links
Configuration Panel on page 18

Configuration Panel
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Selecting sound devices
About this task
Use the sound settings to specify the audio devices for your calls and to configure the volume
settings.

Procedure
1. In the Avaya one-X® Communicator window, click the Sound settings icon.

2. Select the required audio device for speakers.

3. Select the required audio device for microphone.

4. Set up the volume setting using the volume slider.

Related links
Configuration Panel on page 18

Using your feature buttons
Feature buttons
Depending on how your extension on the Avaya Aura® Communication Manager system is
administered, you can see the Feature buttons on your Avaya one-X® Communicator.
To see the Feature buttons available for your use, click the Dialpad icon. If you do not see some of
these feature buttons in your Dialpad window, contact your system administrator. The feature
buttons available for you to use can be customized using the Centralized Administration Tool.
The following telephony features are available with both H.323 (Advanced Telephony) and SIP
(Advanced SIP Telephony) protocols depending on how your extension on the Communication
Manager system is administered:

Note:
Avaya one-X® Communicator does not support some of the AST features in the Other Phone
mode. However, you can use Avaya one-X® Communicator for making and receiving calls, and
for handling mid-call controls.

Feature Description
Automatic Call Back Enables a user to set up a call back request if the telephone of the called

party is busy. By default three call appearances are available. One of the
call appearances is always reserved for making outgoing calls. If the rest
two call appearances are busy then Automatic Call Back feature can be
enabled by the calling party.

Call Forwarding All Calls Enables a user to forward all calls to any extension.

Table continues…
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Feature Description
Call Forwarding Busy/Don't
Answer

Enables a user to forward calls to any extension when the user's
extension is busy or when the user does not answer.

Call Park and Call Retrieve In SIP mode, the Call Park feature enables a user to place the current call
in the call park state and the Call Retrieve feature enables the user to
retrieve the parked call. In H.323 mode, the Call Park button enables call
parking as well as call retrieving.

Calling Party Number Blocking Enables a user to block the sending of the calling party number for a call.
Calling Party Number
Unblocking

Enables a user to deactivate the Calling Party Number Blocking feature
and allows the calling party number to be sent for a single call.

Call Pickup (Group, Directed,
and Extended Group)

With Call Pickup, a user creates a call pickup group. All group members
can answer a call during ringing state in the group from their own
telephones. The Call Pickup button is highlighted and by clicking this
button group members can answer the call.

With Directed Call Pickup, a user specifies which ringing telephone a user
want to answer from your telephone. A call pickup group is not required.

With Extended Call Pickup Group, Avaya one-X® Communicator prompts
for a group number. Users within an "extended" group can then answer
calls outside of their immediate group by entering a feature access code
(FAC) followed by the one-digit or two-digit pickup (index) number.
However, the users need not enter FAC if it is administered on the
telephone.

Limit Number of Concurrent
Calls

With the Limit Number of Concurrent Calls feature, users can have only
one call at a time. When a call is in progress and the Limit Number of
Concurrent Calls feature is active, Avaya one-X® Communicator does not
display any other incoming call until Avaya one-X® Communicator goes
into an idle state. Users can see the Limit Number of Concurrent Calls
feature button only if the feature has been administered for their
extension.

Malicious Call Trace Enables a user to send a message to the MCT control extensions that the
user wants to trace a malicious call.

One-step Recording Enables a user to activate and deactivate the recording of active calls to
Audix.

Priority Calling Enables a user to dial a feature access code or use the Priority feature
button (if administered on your call server) to originate a priority call.
Priority calls ring differently and override the Send All Calls feature, if
active.

Send All Calls Enables a user to direct all incoming calls to coverage.
Transfer to Voicemail Enables a user to transfer the caller to Audix mail where the caller can

leave a message.
Whisper Page Enables a user to make and receive whisper pages. A whisper page is an

announcement that is sent to another extension that is active on a call.
Only the party on the extension hears the announcement. No other
parties on the call hear the announcement.

Table continues…
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Feature Description
EC500 Enables a user to divert calls to its office phone to other phones. Using

this feature incoming calls to your office number reach you on the road, at
another location, or even walking around the workplace. When you
cannot respond, your voice mail picks up your messages.

Team Button Enables a user to monitor the members of a team of stations. Members of
a team can be of any station type with multiple call appearance displays
and administrable feature buttons. Team button constitutes of Speed Dial,
Pickup, Busy Indicator and Override Send All Calls/Call Forward (SAC/
CFWD) features in one button. The Speed Dial, Pickup, Busy Indicator
features are enabled by default. The Override SAC/CFWD feature is
enabled by your administrator.

Enhanced Call Pickup with
Alerting

Enables users to answer calls for one another if the users are members
of the same pickup group. The feature has been enhanced to provide
display of calling and called party information. You can get the enhanced
features if you are using Communication Manager Release 5.2 or later.

Enhanced Call Forwarding Enables a user to set up forwarding of incoming calls to different
destinations depending on whether the incoming calls are from internal or
external sources.

Login dialog box
The Login dialog box enables you to log into Avaya one-X® Communicator.

Setting Description
User Name If Avaya one-X® Communicator is integrated with

Avaya one-X® Client Enablement Services, enter
your user name on the server in this box.

Extension If it is not integrated with Client Enablement
Services, enter your extension in this box.

Password Enter your password.
Place and receive calls using Select a login mode for placing and receiving calls.
Log In Click to log in to the server.

Phone Number List Dialog Box
The Phone Number List dialog box displays the devices and telephone numbers you have specified
for Avaya one-X® Communicator.

Use this dialog box to:

• Add a device or a telephone number

Getting started
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• Modify an existing device or a telephone number

• Delete a device or a telephone number

Field Description
Add Enables you to add a device or telephone number on

which you want to make and receive calls.
Edit Enables you to modify the selected device or

telephone number in list box.
Remove Enables you to delete the selected device or

telephone number in the list box.

Add Phone dialog box
Use the Add Phone dialog box to add a device or a telephone number on which you want to make
and receive calls.

Field Name Description
Number Telephone number you want to use.
Name The label for the telephone number. This label is

displayed as an option in the Place and receive calls
using box in the Welcome dialog box.

Type Category for this telephone number. Your choices
are:

• Home

• Work

• Mobile

• Pager
Format Format in which the entered phone number is

dialled. The telephone number you specified will be
dialed according to your dialing rules.

Edit Phone dialog box
Use the Edit Phone dialog box to edit the details of a device or a telephone number on which you
want to make and receive calls.

Field Name Description
Number Telephone number you want to use.

Table continues…
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Field Name Description
Name The label for the telephone number. This label is

displayed as an option in the Place and receive calls
using box in the Welcome dialog box.

Type Category for this telephone number. Your choices
are:

• Home

• Work

• Mobile

• Pager
Format Format in which the entered phone number is

dialled. The telephone number you specified will be
dialed according to your dialing rules.

Audio statistics field descriptions
While a call is in progress, you can view the following statistics in the Audio Statistics window:
Volume: 

Name Description
Microphone Volume of the microphone while on a call.
Speaker Volume of the speaker while on a call.

VOIP Traffic Information: 
This section displays the characteristics of the current voice connection.

Name Description
Destination Address IP address of the destination that is receiving the

voice packets.
Codec sent Type of codec that Avaya one-X® Communicator

sends for this login session.
Codec received Type of codec that Avaya one-X® Communicator

receives for this login session.
Local Encryption Indicates whether the local audio stream is using

encryption.
Traffic Status of the audio stream (for example, receive

only, transmit only, or receive and transmit both).
Packet loss The number of packets lost during the call.

Table continues…

Getting started

November 2015 Using Avaya one-X® Communicator 24
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya one-X® Communicator


Name Description
Jitter Displays the size of the jitter buffer, which stores

packets to ensure a consistent delivery of voice to
your speakers or headset so the voice stream you
hear does not contain gaps. The larger the jitter
buffer, the longer the delay in receiving audio from
the other party.

Perceived Delay The amount of time taken for the audio to reach you
from the other party on the call (that is, the time that
elapses between the other party speaking and you
hearing that person's words).

Quality The level of audio quality for the current call.

Audio Status: 

Name Description
Silence Suppression Enabled Displays whether the Suppress Silence setting is

enabled during the call. Whether this setting is
enabled for the current call depends on the server
you are logged into. When this setting is enabled,
“Silence Suppression” is displayed when you do not
speak.

Audio statistics field descriptions
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Chapter 3: Using Avaya one-X®
Communicator with other
applications

Using Avaya one-X® Communicator with Avaya one-X®

Client Enablement Services
You must have an Avaya one-X® Client Enablement Services account if you want to integrate Avaya
one-X® Communicator with Avaya one-X® Client Enablement Services. Contact your system
administrator for more information.
When you integrate Avaya one-X® Communicator with Avaya one-X® Client Enablement Services,
you can:

• Access your contacts in Client Enablement Services;
• Access Client Enablement Services-based call history;
• Use bridge conferencing;
• Access your visual voice mail messages;
• Change your personal message;
• Manage ring phones;
• Select block calls or allow VIP calls option;

Refer to Configuring login settings on page 32 chapter for the login configuration details.

Using Avaya one-X® Communicator in the Citrix
Environment

If you are using Avaya one-X® Communicator in the Citrix environment, the Avaya one-X®

Communicator files reside on the Citrix server. You can set your dialing rules using Avaya one-X®

Communicator.
The following features are not supported in the Citrix environment:

• Video
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• This Computer mode (Road Warrior configuration)
• Click-to-Dial feature

Note:
If you are using Avaya one-X® Communicator as a published application in the Citrix
environment, you must use a resolution of 1024 x 768 or higher.

Using Avaya one-X® Communicator with Microsoft Office
Communicator

Before you begin
If you install Avaya one-X® Communicator with Microsoft Office Communicator, you can send instant
messages from one communicator to the other.

About this task
To send a message from Avaya one-X® Communicator to Microsoft Office Communicator:

Procedure
1. Click the Show Contacts button to display your contacts.

2. Click the Launch IM button for a contact, and select Microsoft Office Communicator.

The chat window appears.

3. Use the chat window to enter your message.

4. Click Send.

Using Avaya one-X® Communicator with Microsoft Outlook
Avaya one-X® Communicator supports integration with Microsoft Outlook 2007 SP1 and SP2,
Microsoft Outlook 2010, and Microsoft Outlook 2013. To integrate Avaya one-X® Communicator with
Microsoft Outlook, you need the Avaya Collaboration Services application installed with Avaya one-
X® Communicator. Avaya Collaboration Services is installed by default when you install Avaya one-
X® Communicator on Windows 7, Windows 8, and Windows 10 operating systems. For more
information on installation, see the Implementing Avaya one-X Communicator guide. You must
update your antivirus regularly to avoid any issues related to Microsoft Outlook integration.
You can use the following Avaya one-X® Communicator features from your Microsoft Outlook client:

• Making and logging calls from Microsoft Outlook.
• Making calls from Microsoft Outlook contacts and from Journal entries.
• Viewing the presence status of your favorite contacts in a federated environment when the

contacts are in “To”, “From”, or “CC” fields in the Outlook email. The presence status of
federated users not included in your favorites list is shown as unknown.

Using Avaya one-X® Communicator with Microsoft Office Communicator
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• Sending instant messages to your favorite federated contacts.
• Viewing the presence note of the users in the Microsoft Outlook contact card. If you use

Microsoft Outlook 2013, you can see the presence note of your favorite contact only if the
contact card is pinned.

• Viewing the available channels of communication of a favorite contact through a Contact card
and making calls to a contact.

• Matching the telephone numbers of incoming calls with your Microsoft Outlook contacts and
displaying the contact names.

Using Avaya one-X® Communicator with web browsers
Avaya one-X® Communicator supports integration with web browsers — Internet Explorer, Mozilla
Firefox, and Google Chrome. To integrate Avaya one-X® Communicator with these browsers, you
need the Avaya Collaboration Services application installed with Avaya one-X® Communicator.
Avaya Collaboration Services is installed by default when you install Avaya one-X® Communicator
on Windows 7, Windows 8, and Windows 10 operating systems. For more information on
installation, see the Implementing Avaya one-X Communicator guide.
You can use the following Avaya one-X® Communicator features from your web browser:

• Making and logging calls from web browsers.
• Making calls from web browsers.
• Viewing the presence status of your favorite contacts in a federated environment when the

contacts appear on the browsers. The presence status of federated users not included in your
favorites list is shown as unknown.

• Sending instant messages to your favorite federated contacts.
• Viewing the presence note of the users.
• Viewing the available channels of communication of a favorite contact and making calls to a

contact.
• Matching the telephone numbers of incoming calls with your Microsoft Outlook contacts and

displaying the contact names.
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Chapter 4: Configuring Avaya one-X®
Communicator

Auto-configuring Avaya one-X® Communicator
Use the Avaya one-X® Communicator Centralized Administration Tool to create a discover.xml
file before you start auto-configuring Avaya one-X® Communicator . You can also create the
discover.xml manually. Contact your system administrator for more information on creating and
using the disocver.xml file.

Before you begin
Ensure that your system administrator has configured automatic discovery settings in the
46xxsettings.txt file that is hosted on your http or https server.

About this task
You can use the Auto-configuration feature to pre-populate some of your configuration fields in
Avaya one-X® Communicator. To use the Auto-configuration feature, perform the following steps:

Procedure
1. In the Avaya one-X® Communicator Login window, click Menu > Settings.

Avaya one-X® Communicator displays the General Settings window with the list of
configuration tabs in the left navigation pane.

2. If you want to apply auto-configuration only to a specific group of settings, click the required
configuration tab in the left navigation pane.

3. Click Auto-configure .

4. In the Auto-configure dialog box, perform any one of the following:

• Click All to apply the auto-configuration feature to all Avaya one-X® Communicator
settings.

• Click This screen only to apply the auto-configuration feature to the current configuration
tab only.

The system displays a message indicating the progress of the auto-configure operation. If
the retrieval is successful, the system displays the Login dialog box. If the retrieval is
unsuccessful, the system displays a message indicating that you must configure Avaya one-
X® Communicator manually before you can log in.
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Configuring the general settings manually

Configuring telephony settings
Procedure
Click Telephony in the left pane of the General Settings window.

The system displays the settings in the right pane of the General Settings window. This pane
displays different fields depending on whether you select H.323 or SIP protocol after installation.

Configuring for H.323 protocol
Procedure

1. Select H.323 as the telephony protocol.

2. Enter the Extension and the Password.

3. To specify the IP address of your server, click Add below the Server List field.

4. In the Add Server dialog box, enter the IP address of the proxy server.

5. Click OK.

6. Repeat Steps 3 to 5 for each server address you want to specify.

7. If you want to use video, ensure that the Enable Video Calls check box is selected.

Configuring for SIP protocol
Procedure

1. Select SIP as the telephony protocol.

2. Enter the Extension and the Password.

3. To specify the IP address of your server, click Add below the Server List field.

4. In the Add Server dialog box:

a. Enter the IP address of the proxy server or Session Border Controller .

Note:

Session Border Controller provides your Avaya one-X® Communicator a remote
access to Avaya Aura® without a VPN connection. The Session Border Controller
feature is available only if configured on the Avaya Aura® system. Refer to Avaya
Aura® administrator for more information.

b. Select a Transport Type.

Note:

Telephony in the Deskphone mode, and IM and Presence are not available with
Transport Control Protocol (TCP).
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c. Enter a port number for the selected Transport Type.

5. (Optional) Enter the Port.
6. Click OK.

7. Repeat Steps 3 to 5 for each server address you want to specify.

8. In the Domain field, enter the domain name.

9. In the Failback Policy field, select Auto or Admin.

10. Select a Registration Policy from the drop-down menu.

Note:

The Mode, Avaya Environment field is read only.

11. If you want to use video, ensure that the Enable Video Calls check box is selected.

Telephony screen field descriptions
Field Name (for H.323 protocol) Description
Extension The extension number of your phone
Password The password for your phone.
Server List The IP address of the Communication Manager

server.
Enable Video Calls The check box to enable video sharing. For this your

administrator must configure your extension on the
server.

Field Name (for SIP protocol) Description
Extension The extension number of your phone.
Password The password for your phone.
Server List The IP address of the proxy server.
Port The port number of the server.

If you do not enter the port number, Avaya one-X®

Communicator uses port 5061 as the default setting.
Domain The domain of your Avaya Aura® Session Manager

server. This field is case sensitive.
Mode The mode of use.
Avaya Environment The field indicates if Avaya one-X® Communicator is

connected to Avaya network.
Failback Policy The field to select if Avaya one-X® Communicator

automatically recovers after a failback. Your options
are:

• Auto
Table continues…
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Field Name (for SIP protocol) Description
• Admin

Registration Policy The drop-down menu to specify how your extension
manages proxies. Your options are:

• Alternate

• Simultaneous
Enable Video Calls The check box to enable video sharing.

For using video calls, your system administrator
must configure your extension on the server.

Configuring login settings
Procedure

1. Click Login in the left of the General Settings window.

The login settings appear in the right pane of the General Settings window.

2. Ensure that the Use Avaya one-X® Client Enablement Services account check box is
selected.

3. In the URL, enter the Web page address of the Avaya one-X® CES server.

4. In the User name, enter your user name.

5. In the Password, enter the password.

6. Click OK.

Login screen field descriptions
Field name Description
Use Avaya one-X® Client Enablement Services
account

Check box to select if you want to integrate with
Avaya one-X® Client Enablement Services account.

URL Fully qualified domain name for the Client
Enablement Services server.

User Name Your user name for the Client Enablement Services
server.

Password Your password for the Client Enablement Services
server.

Configuring personal call feature
The Personal call page is displayed on the Avaya one-X® Communicator user interface only if you
have enabled the feature using the Avaya one-X® Communicator Admin Control Tool.
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Procedure
1. Click Personal call in the left pane of the General Settings window.

2. Enter the Feature Code.

3. Enter the Account Code.

4. Click OK.

Personal call screen field descriptions
Name Description
Feature code Code that is used to access the personal call feature

on the call servers. The default value is *75.
Account code Code that is used to authenticate outgoing personal

calls.

Configuring messaging settings
About this task
Set Avaya one-X® Communicator to access your messaging system when you click the message
waiting indicator on the Avaya one-X® Communicator window.

Procedure
1. Click Messaging in the left pane of the General Settings window.

2. Select the Enable Message Access check box.

3. Perform one of the following:

• Select Dial this number or enter the telephone number you want to dial to access the
messaging system.

• Select the Start This Application option or click Browse to select the application you
want to run.

• Select the Open Webpage option or enter the Web URL for the messaging system.

4. Click OK.

Messaging screen field descriptions
Field Name Description
Enable Message Access Check box to enable access to the messaging

system.
Dial this number Number to be dialed to access the messaging

system.

Table continues…
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Field Name Description
Start This Application Application to be opened to access the messaging

system.
Open Webpage Web browser to be opened to access the messaging

system.

The following fields are displayed if you integrate Avaya one-X® Communicator with Avaya one-X®

Client Enablement Services:

Field Name Description
Messaging Server Name of the Messaging server.
Display Name Display name of the Messaging server.
Mailbox Your Mailbox number.
Password Password to access your Mailbox number.
Web Subscriber Options URL URL to be opened to access your messages.

Configuring conference settings
You can view and modify the bridge conference settings on this screen if you have integrated Avaya
one-X® Communicator with Avaya one-X® Client Enablement Services. System populates the fields
in the Conference screen with bridge conference attributes from Avaya Meeting Exchange.

Procedure
1. Click Conference in the left pane of the General Settings window.

The Conference screen appears in the right pane of the General Settings window.

2. Ensure that the values in the fields are accurate and modify, if required.

Conference screen field descriptions
Field name Description
Bridge Conference Server Name of bridge conference server.
Display Name Display Name of the user.
Primary Phone Number Primary phone number to be used for bridge

conferencing.
Alternate Phone Number Alternate phone number to be used for bridge

conferencing.
Moderator Code Moderator code to be used for bridge conferencing.
Participant Code Participant code to be used for bridge conferencing.
PIN PIN number for the conference.
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Configuring mobile account settings
If your system administrator has configured your account for Avaya one-X® Mobile, you can update
your mobile number and SMS address in this screen. Mobile account configuration is available only
if you have integrated Avaya one-X® Communicator with Avaya one-X® Client Enablement Services
by configuring Login settings. For more information, see Configuring login settings on page 32.

Procedure
1. Click Mobile in the left pane of the General Settings window.

The Mobile Account screen appears in the right pane of the General Settings window.

2. Enter a Phone Number, if required.

3. Enter an SMS Address, if required.

4. (Optional) To remove the mobile phone from your account, click Block This Phone.

5. Click OK.

Mobile Account screen field descriptions
Field name Description
Phone Number Mobile phone number.
SMS Address SMS address.
Block This Phone The button to remove the mobile phone from your

account.

Configuring instant messaging and presence settings
Using this window, you can activate the Avaya one-X® Communicator Instant Messaging
functionality.

Procedure
1. Click IM and Presence in the left pane of the General Settings window.

2. To enable IM and Presence, select the Enable Instant Messaging and Presence check
box.

3. In the Server field, enter the IP address of IM and Presence server.

4. In the Domain field, enter the domain name of the Presence server.

5. Perform any one of the following actions:

• For SIP protocol, select the Automatically discover my IM login information option.

• For H.323 protocol, select the Manually specify my IM login information and enter the
IM username and IM password in the respective fields.
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6. To store instant messages on your hard disk drive, select the Enable Local Message
Archiving check box.

7. Click the Preferences tab and select the options as appropriate.

Note:

The check box, Activate the "Send all calls” feature (if available) when presence is set
to ”Do not disturb”, is open for selection only if the feature is available for the extension
and has been activated using the Centralized Administration Tool.

8. Click the Access Control tab and select Allow or Deny for a contact depending on whether
you want to provide your presence to that contact.

9. Click OK.

IM and Presence screen field descriptions
Field Name Description
Enable Instant Messaging and Presence Settings Check box to indicate if instant messaging and

presence functionality is to be used.
Server IP address of the instant messaging and presence

server.
Domain Domain of the presence server. In SIP protocol

mode, if you do not specify the domain name or
specify an incorrect domain name, Avaya one-X®

Communicator fetches and populates the associated
domain name.

Automatically discover my IM login information Check box to select if you are opting for
automatically discovering an IM login.

Manually specify my IM login information Check box to select if you are opting for manually
specifying an IM login.

IM username User name to be used for instant messaging.
IM Password Password required for using instant messaging.
Enable Local Message Archiving Check box to indicate if IM messages are to be

archived in the local drive.
Set Away when I’ve been inactive for ... minutes Check box to select if you want the presence status

to be changed to Away when you are inactive for a
certain period of time (The default value is 10
minutes). You can set the value from 5 to 100
minutes.

Activate the "Send all calls” feature (if available)
when presence is set to ”Do not disturb”

Check box to select if you want to activate the "Send
all calls” feature when presence is set to ”Do not
disturb”. The check box is open for selection only if
the feature is available for the extension and has
been activated through the Centralized
Administration Tool.
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Field Name Description
Enable dialable number parsing in message text Check box to enable dialable number parsing in

message text.
Enable hyperlink parsing in message text Check box to enable hyperlink parsing in message

text.
Store Instant Message History for the last ... days Drop-down menu to indicate the number of days for

which the IM messages should be stored.
Open History Folder Field to open the IM history folder.
Name Name of your Favorite contact.
Access Drop-down menu to indicate if you want to provide

your presence access to the contact.

Configure security settings
Avaya one-X® Communicator supports the following certificates:

• Avaya Product Root Certificate Authority (CA): Embedded in Avaya one-X® Communicator.
• Certificate issued by the Trusted Third Party Certificate Authority (TTP CA) and stored in the

system certificate store: X.509 certificates other than the Avaya Root certificate that are loaded
to your computer.

Avaya one-X® Communicator supports certificates with 2048–bit RSA keys and SHA-256 digests
and uses the selected certificate for two-way Transport Layer Security (TLS) authentication during
the handshake stage of establishing secure connections with:

• SIP
• Extensible Messaging and Presence Protocol (XMPP)
• HTTPS
• Session Border Controller
• Avaya one-X® Client Enablement Services
• Lightweight Directory Access Protocol (LDAP)

The client identity certificate is distributed by administrators and must be installed on Avaya one-X®

Communicator.

Note:
If you install Avaya one-X® Communicator in the Silent mode, you must enable the Avaya
Product Root Certificate Authority (CA). The Avaya CA certificate is installed and configured on
Session Manager and Avaya one-X® Communicator uses the Avaya CA client identity certificate
by default, unless you configure certificates issued by a Trusted Third Party Certificate Authority
(TTP CA).

Related links
Checking the certificate details on page 38
Selecting the client identity certificate on page 38
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Checking the certificate details
If you are going to use client identity certificate issued by TTP CA, ensure the certificate is available
in the Personal Certificates store and is valid.

About this task
To check the client identity certificate details, perform the following steps:

Procedure
1. Log on to the system as an administrator.

2. From the command prompt, run the mmc command.

3. Click File > Add/Remove Snap-in, and then click Add.

4. Under Snap-in, double-click Certificates, click Computer account, and then click Next.
5. Click Local computer, and then click Finish. Click Close.

The Certificates (Computer Name) snap-in appears on the list of selected snap-ins for the
new console.

6. Browse to Certificates > Personal > Certificates.

7. Double-click the client identity certificate and verify the following certificate information:

• The value for KeyUsage extension field is Digital Signature and keyEncipherment bits
set to 1.

• The EnhancedKeyUsage extension includes object identifiers either for the Server
Authentication (1.3.6.1.5.5.7.3.1) or the Client Authentication (1.3.6.1.5.5.7.3.2) or
both.

• The certificate and the trust chain is valid and does not have any errors such as incorrect
signature, and expired validity period.

• The certificate has passed through revocation checking.

• The certificate is trusted. The client non-default identity certificate is validated against the
Trusted Root Certification Authorities system certificate store.

• The private key of the certificate is marked as exportable.

Related links
Configure security settings on page 37

Selecting the client identity certificate
Use the Security settings tab to enable your client certificate issued by the Trusted Third Party
Certificate Authority (TTP CA) in Avaya one-X® Communicator.

Before you begin
Verify your client identity certificate is installed on your computer and is valid. Refer to Checking the
certificate details on page 38

Configuring Avaya one-X® Communicator

November 2015 Using Avaya one-X® Communicator 38
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya one-X® Communicator


About this task
To select the client identity certificate in Avaya one-X® Communicator, preform the following steps:

Procedure
1. Click Security in the left pane of the General Settings window.

2. Click Browse to select a certificate from the Certificate store in your computer.

3. Click OK.

Related links
Configure security settings on page 37

Security screen field descriptions

Name Description
Identity Certificate Check box to select a client identity certificate issued

by the Trusted Third Party Certificate Authority (TTP
CA) and stored in the system certificate store.

Configuring offline call journaling settings
About this task
The Call Journaling feature provides the Avaya one-X® Communicator users a consistent and
continuous view of call logs generated when a device is logged in or not logged in. The Offline Call
Journaling feature is available to users in H.323 mode as well as SIP mode. In H.323 mode, users
need to configure Offline Call Journaling through the Avaya one-X® Communicator user interface.
The following settings are applicable only to Avaya one-X® Communicator in H.323 mode.

Procedure
1. Click Offline Call Journaling in the left pane of the General Settings window.

2. Select the Enable Offline Call Journaling check box.

3. In the Backup server URL field, enter the Web page address of the Backup and Restore
server.

4. In the Login field, enter the enter the user name, used for accessing the Backup and
Restore server.

5. In the Password field, enter the password for accessing the Backup and Restore server.

Related links
Offline call journaling screen field descriptions on page 40
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Offline call journaling screen field descriptions
Name Description
Enable Offline Call Journaling Check box to indicate if Offline Call Journaling

functionality is to be used.
Backup server URL Web page address of the Backup and Restore

server. Avaya one-X® Communicator supports both
HTTP and HTTPS connections to backup/restore
server.

Login User name to be used for accessing the Backup and
Restore server. The Login field is optional and
depends on the configuration of the backup/restore
server.

Password Password required for accessing the Backup and
Restore server. The Password field is optional and
depends on the configuration of the backup/restore
server.

Related links
Configuring offline call journaling settings on page 39

Configuring outgoing call settings
Procedure

1. Click Outgoing Calls on the left pane of the General Settings window.

2. From the Place and receive calls using drop-down menu, select an option.

The Other Phone mode is enabled only when you add numbers using the Phone Numbers
screen.

3. For H.323 protocol, ensure that the Enable Emergency Call Handling Feature check box is
selected and perform any one of the following actions:

• Select Your extension number.
• Select Telephone number and type the phone number to be used during an emergency.

Contact your system administrator for more details on Emergency number administration for
your extension with the H.323 protocol.

4. Click OK.

Note:

This feature is not supported when you are using Avaya one-X® Communicator through
a remote desktop connection or a virtual computer.
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Outgoing Calls screen field descriptions
Field Name Description
Place and receive calls using Avaya one-X® Communicator uses the option

selected here to place and receive calls. The
available options are:

• This Computer: This mode enables you to use the
full feature set of your company telephone system
from temporary locations anywhere in the world
(such as a hotel room). This mode is configured for
voice over IP (VoIP). Make and handle calls
through the Avaya one-X® Communicator interface
on your computer, and use the inbuilt microphone
and speakers of the computer or an externally
connected headset to speak and listen.

• Desk Phone: Using this mode, you can log in to
the server and control your Avaya telephone from
Avaya one-X® Communicator. You can make and
handle calls from both the Avaya one-X®

Communicator interface and your Avaya
telephone. Use your Avaya telephone to speak and
listen. When the connection to the phone is lost
and can’t be established after several attempts, a
warning message is thrown to inform the customer.

• Other Phone: With this mode, you can use the full
feature set of your company telephone system
from a location other than your office. You place
and handle calls through the Avaya one-X®

Communicator interface, and you use a separate
telephone line at your remote location to speak and
listen. Unlike This Computer mode, this mode is
configured for toll-quality audio and optimizes
audio through the other phone. To use this mode,
you must have a separate telephone line available
at your remote location.

Note:

In the DeskPhone mode and Other Phone
mode, Avaya one-X® Communicator does not
display numbers (DTMF) dialed from a hard
phone during an active call.

Enable Emergency Call Handling Feature (For H.
323 protocol only)

Check box to enable Emergency Call Handling.

Your extension number (For H.323 protocol only) Check box to select if you want Avaya one-X®

Communicator to use your extension number during
an emergency call.
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Field Name Description
Telephone number (For H.323 protocol only) Check box to select if you want Avaya one-X®

Communicator to use any other phone during an
emergency call. Use the text field to enter the
telephone number to be used during an emergency
call.

Configuring phone number settings
About this task
Use the screen to add phone numbers that you plan to use through Avaya one-X® Communicator.

Procedure
1. Click Phone Numbers on the left pane of the General Settings window.

2. Click Add.

a. Enter a Name.

b. Enter a Number.
c. Click OK.

3. Click Format to view the specified number with the dialing rules applied to it.

4. Click OK.

Phone Numbers screen field descriptions
Field Name Description
Phone Numbers List of phone numbers added through this screen.
Name Name assigned to a number.
Number Telephone number added.
Format Displays the selected phone number with the dialing

rule applied to it.

Configuring call handling settings
About this task
Use the screen to block or allow incoming calls and select telephones to ring for incoming calls. Call
Handling configuration is available only if you have integrated Avaya one-X® Communicator with
Avaya one-X® Client Enablement Services by configuring the Login settings.

Procedure
1. Click Call Handling in the left pane of the General Settings window.
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2. Select an option from the Call Handling drop-down menu. Your options are:

• Block All calls
• Allow VIP calls
• Do not block

3. Select the phones from the list of phones appearing under Ring Phones.

The list of phones contains phone numbers that you have added using the Phone Numbers
screen.

4. Click OK.

Call Handling screen field descriptions
Field Name Description
Call Handling Drop-down menu to block or allow calls. Your options

are:

• Block All calls: Blocks all incoming calls

• Allow VIP Calls: Allows calls from the contacts
that are added to your VIP list.

• Do not block: Allows all incoming calls
Ring Phones Check boxes against telephone numbers to Indicate

which telephones to ring for incoming calls. The list
of telephone numbers contains telephone numbers
that you have added using the Phone Numbers
screen.

Configuring dialing rules settings
Procedure

1. Click Dialing Rules on the left pane of the General Settings window.

2. In the General Settings window, enter the number to dial in the Number to dial to access
an outside line field

3. Enter values in the Your country code, Your area/city code, PBX Main Prefix, Number to
dial for long distance calls, and Extension length for internal extensions calls fields.

For example, if your internal extensions consist of five digits, you would enter 5. In this
example, any number that consists of five digits or less would be treated as an internal
extension. If your company supports internal extensions of varying lengths, for example,
three-digit, five-digit, and seven-digit extensions, you must separate these lengths by
commas and enter 3, 5, 7.
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Note:

If you specify multiple extension lengths, Avaya one-X® Communicator performs exact
matches. For example, if you specify 3, 5, 7, Avaya one-X® Communicator treats three-
digit numbers, five-digit numbers, and seven-digit numbers as internal extensions. In this
example, if you dial a one-digit, two-digit, or four-digit number, Avaya one-X®

Communicator does not recognize the numbers to be internal extensions.

4. Enter a value in the Number to dial for international calls field.

5. Enter a value in the Length of national phone numbers (including area/city code) field.

6. If you entered an area or city code in Step 4, select the Include area/city code when
making a local call check box.

For example, for Lincroft area in the U.S., entering an area code is mandatory. Therefore,
you must select the check box. However, for Basking Ridge area in the U.S., entering an
area code is not mandatory, so you need not select the check box.

7. Select the Display confirmation window before dialing a number check box.

This ensures that you can check whether the number to be dialed conforms to the dialing
rules you set. If not, you can update the number. Avaya one-X® Communicator then uses the
updated number to make calls.

8. Click OK.

Dialing Rules screen field descriptions
Field Name Description
Number to dial to access an outside line Number to dial to access an outside line.
Your country code Your country code.
Your area/city code Area code or the city code where your phone server

is located.

You can enter multiple codes and separate them with
commas. For example, if you enter code as 406 or
208,Avaya one-X® Communicator treats every call
made to a region matching with either 406 or 208 as
a local call.

PBX Main Prefix Main prefix of your PBX.
Number to dial for long distance calls Number to dial before you make a long distance call.
Number to dial for international calls International country code for dialing an international

phone number.
Extension length for internal extensions calls Number of digits that comprise an internal extension.
Length of national phone numbers (including
area/city code)

It is either:

• the number of digits to dial (including area/city
code) for a call within your country.
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Field Name Description
• the supported phone number lengths separated by

a comma for countries with multiple phone number
lengths.

Apply dialing rules for outgoing calls Avaya one-X® Communicator applies the specified
dialing rules to outgoing calls.

Include area/city code when making a local call Check box to indicate if the area/city code must be
included in the number for making a local call.

Display confirmation window before dialing a
number

Application displays a confirmation window before it
dials a number.

Configuring audio settings
Procedure

1. Click Audio in the left pane of the General Settings window.

2. On the General Settings window, select the Basic tab.

3. Select a Microphone from the drop-down menu.

4. Select a Speaker from the drop-down menu.

5. Select the Ring on incoming calls check box, if required.

6. Select the Ring additional device check box, if required, and select a device from the drop-
down menu.

7. Click OK.

Note:

Audio feature is not supported when you are using Avaya one-X® Communicator through
a remote desktop connection or a virtual computer. For more information on audio
settings, see Using Avaya one-X® Communicator on the Avaya Support Web site http://
www.avaya.com/support.

Audio screen field descriptions
Field Name Description
Microphone Microphone to be used for a call.
Speaker Speaker to be used for ringing and calls.
Ring on incoming calls Check box for selecting if ringing for incoming calls

must be enabled.
Ring additional device Additional audio device for ringing.
Mute ringing for incoming calls Check box for selecting if ringing for incoming calls

must be muted.
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Audio Advanced screen field descriptions
Field Name Description
Microphone Microphone to select from a list.
Speaker Speaker to select from a list. Click the Up or Down

arrow keys to move the device up or down
respectively.

Configuring video settings
Procedure

1. Click Video in the left pane of the General Settings window.

2. Select the Send your video image automatically when you answer or join a video call
check box, if required.

3. To enable Picture in Picture (PIP) and configure the PIP settings, select the Display a
picture-in-picture window check box and select one of the following options:

• Select Small picture-in-picture window check box.

• Select Medium picture-in-picture window check box.

• Select Large picture-in-picture window check box.

4. To keep the PIP window fixed at a location, select the Fixed picture-in-picture window
check box.

5. Select the Stretch video to fit screen check box, if required.

6. Select the Display warning before entering Full Screen mode check box, if required.

7. Select the Automatically disable screen saver and monitor power saving mode during
a call check box, if required.

8. Click the Advanced tab and configure the following:

a. Select a camera from the Preferred Camera drop-down menu.

b. Select a preferred bit rate from the User Session Maximum Bit Rate drop-down menu.

For video conference in SIP mode using Avaya Aura® Conferencing, you must set the
User Session Maximum bit rate to at least 384 kbps.

c. Select the Show the video window automatically on login with video capabilities
check box, if required.

9. Click the Administration tab and select the Codecs.

10. Click OK.
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Note:

Video feature is not supported when you are using Avaya one-X® Communicator through
a remote desktop connection or a virtual computer. For more information on video
settings, see Using Avaya one-X® Communicator on the Avaya Support Web site http://
www.avaya.com/support.

Video screen field descriptions
Field Name Description
Open Video Window Opens the video window if it is not opened.
Send your video image automatically when you
answer or join a video call

The check box to indicate your video image is
automatically sent when you answer or join a video
call.

PIP Settings Picture in Picture settings. The options are:

• Display a picture-in-picture window: Displays
the near-end video and the far-end video in the
same window.

• Small picture-in-picture window: Provides a
small picture-in-picture window

• Medium picture-in-picture window: Provides a
medium size picture-in-picture window.

• Large picture-in-picture window: Provides a
large picture-in-picture window

• Fixed picture-in-picture window location:
Provides the picture-in-picture window at a fixed
location

Stretch video to fit screen The check box to indicate if the video is to be
stretched to fit the screen on a full screen video
mode.

Display warning before entering Full Screen
mode

The check box to indicate if a warning must be
displayed when you click the icon on the video
window to display the video in the full screen mode.

Automatically disable screen saver and monitor
power saving mode during a call

The check box to specify if the following be disabled:

• screen saver to become active during an active
video call.

• the monitor to switch to the power saving mode
during an active video call.

Preferred Camera The drop-down menu to select a preferred camera.
User Session Maximum Bit Rate The drop-down menu to select the maximum bit rate.
Show the video window automatically on login
with video capabilities

The check box to indicate your preference for
displaying the video window at login.
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Field Name Description
Codec Preferences The check boxes to select video codecs. The

supported codecs are:

• H.263

• H.263–1998

• H.264

You can select the codecs only if you have enabled
video calls from the Telephony screen. For more
information, see Configuring telephony settings on
page 30.

Configuring public directory settings
Before you begin
Before you gain access a public directory, you must select the Public Directory check box in the
Preferences screen. For the procedure, see Configuring preferences settings on page 50.

Procedure
1. Click Public Directory in the left pane of the General Settings window.

2. From the Directory Type drop-down menu, select one of the following types of directories:

• Active Directory
• Domino
• Novell
• Sun One Directory

3. Enter appropriate information in the Directory Name, Server Address, User name,
Password, Search Root, Transport Type, Server Port, Time out, and Max Entries fields.

4. If you are using H.323 protocol, select an option from the IM Handle Mapping drop-down
menu.

5. Select the Use Active Directory GSS Bind check box, if required.

For information on the fields, see Public Directory screen field descriptions on page 48.

6. Click OK.

Public Directory screen field descriptions
Field Name Description
Directory Type The type of public directory.
Directory Name The name of the directory server.

Table continues…
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Field Name Description
Server Address The IP address of the directory server.
User Name Your user name.
Password Your password.
Search Root The search root. An example is ou=people,

o=company.
IM Handle Mapping (H.323 mode) The Instant Messaging (IM) handle to be used in H.

323 mode. Avaya one-X® Communicator maps the
IM handles with LDAP attributes to retrieve contact
information for Enterprise users when they are
added as Favorites. The retrieved LDAP value is
then converted to make it the Presence handle. Your
IM handle options are:

• Email Address

• Work Number

• Mobile Number

• Home Number

• Pager Number

• Other
Attribute Name (H.323 mode) The Attribute Name field displays the name of the

attribute in LDAP that stores the Extensible
Messaging and Presence Protocol (XMPP) IM
handle. Avaya one-X® Communicator maps the IM
handle with the Attribute Name in directory lookup.
Hence, all LDAP users must have the Attribute
Name that is specified on the screen. If you select
Other as the IM handle, Avaya one-X®

Communicator displays the Attribute Name field. The
default value of the attribute name is
Extensionattribute14. However, administrators can
modify the value using the Centralized
Administration Tool.

Domain Substitution The Domain Substitution check box indicates if
contacts in search results of public directory must
have their presence domain substituted with the
presence domain specified in Avaya one-X®

Communicator. The field cannot be modified from
the user interface.

Transport Type The protocol to be used. The available options are
TLS and TCP.

Server Port The port number of the server. The default value for
TLS is 636 and for TCP is 389.
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Field Name Description
Time out The time out interval. The default value is 100

seconds.
Max Entries The maximum number of matching entries to display

when you enter a search.

The default value is 25.
Use Active Directory GSS Bind The check box to indicate that Avaya one-X®

Communicator uses the login and password of the
current user to bind with the Active Directory LDAP
server.

Configuring preferences settings
Procedure

1. Click Preferences in the left pane of the General Settings window.

2. Enter a display name in the My display name field.

3. Select a Language for the interface from the drop-down menu.

4. Select the Display alerts for incoming calls check box if required.

The Show Details check box is enabled.

5. Select the Show details check box if required.

6. Select the Automatically login if possible when application restarts check box if
required.

7. Select the Run Avaya one-X Communicator automatically when I log on to Windows
check box if required.

8. Select the Display DTMF digits for active call check box if you want DTMF digits to appear
on the User Interface when you are on an active call.

9. Select the Minimize Avaya one-X Communicator to the task tray check box if required.

10. Select a Display Name format.

11. Click Sound Settings
a. On the Sound settings window, select a Sound Scheme.

b. On the Program Events, scroll down to Avaya one-X Communicator and select a type of
alert.

c. From the Sounds drop-down menu, select a ring tone.

12. Click OK.
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Preferences screen field descriptions
Field Name Description
My display name The text box to enter your display name. The text

box is displayed only when you are using Avaya one-
X® Communicatorwith Avaya one-X® Client
Enablement Services.

Language for the interface The display language for the Avaya one-X®

Communicator interface.
Display alerts for incoming calls The check box to enable alerts for incoming calls.
Show details The check box to indicate if the details of an

incoming call must be displayed to the user. You can
select the check box only if you select the Display
alerts for incoming calls check box.

Automatically login if possible when application
restarts

The check box to indicate if Avaya one-X®

Communicator must automatically log in when the
application restarts.

Run Avaya one-X Communicator automatically
when I log on to Windows

The check box to indicate if Avaya one-X®

Communicator must automatically run when you log
in to your system.

Display DTMF digits for active call The check box to indicate if DTMF digits entered
during an active call must be displayed on the user
interface.

Minimize Avaya one-X Communicator to the task
tray

The check box to indicate if Avaya one-X®

Communicator can be minimized to the task tray
Display Name The format for displaying the names of your

contacts.
Sound Settings The Sound Settings button helps you configure

customized ring tones for call and instant messaging
alerts on Avaya one-X® Communicator. You can
configure customized ring tones for the following
alerts in SIP mode:

• Incoming Call

• Incoming Bridged Call

• Incoming Call Pickup Group Call

• Incoming Team Call

• Incoming IM

You can configure customized ring tones for the
following alerts in H.323 mode:

• Incoming Call

• Incoming IM
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Configuring desktop integration settings
Procedure

1. Click Desktop Integration in the left pane of the General Settings window.

2. Select the Enable Avaya Collaboration Services check box, if required.

3. For Name Look-Up, select from the options, as required:

• Microsoft Outlook Contacts
• Enable Name Look-Up for incoming and outgoing calls
• Minimum number of digits to match:
• IBM Lotus Notes Contacts
• Public Directory

Note:

If you have logged in to Avaya one-X® Communicator in the standalone mode with H.
323 protocol, you must configure the LDAP server and select Public Directory for
Name Look-Up to use the Presence feature. For more information on configuring
Public Directory settings, see Configuring public directory settings on page 48.

You must select Public Directory if you want to add Contacts through the Avaya one-
X® Communicator user interface.

Note:

Avaya Collaboration Services does not support secure LDAP connections.

• Avaya SIP Personal Profile Manager (PPM) Contacts (only with SIP protocol)

• Avaya one-X® Client Enablement Contacts
4. Select Enable wipe-to-dial (clipboard dialing).

In any application, if you select a number that can be dialed, you can dial that number from
the Avaya one-X® Communicator icon in the system tray.

5. Click OK.

Related links
Desktop Integration screen field descriptions on page 52

Desktop Integration screen field descriptions
Field Name Description
Enable Avaya Collaboration Services The check box to select if you want to enable Avaya

Collaboration Services. Avaya Collaboration
Table continues…
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Field Name Description
Services integrates Avaya one-X® Communicator
with the following applications:

• Microsoft Internet Explorer

• Google Chrome

• Mozilla Firefox

• Microsoft Office applications

• Microsoft Office 365
Microsoft Outlook Contacts The check box to select if you want Avaya one-X®

Communicator to search for contacts in Microsoft
Outlook when you use the Name Look-Up feature.
Microsoft Outlook must be installed and running on
your computer.

Enable Name Look-Up for Incoming and
Outgoing calls

The check box to select if you want to enable name
look-up for incoming and outgoing calls in Outlook
contacts.

Minimum number of digits to match The field to enter minimum number of digits to match
with the contacts. You must select the Enable Name
Look-Up for Incoming and Outgoing calls check
box to activate this field.

IBM Lotus Notes Contacts The check box to indicate if Avaya one-X®

Communicator must search for contacts from Lotus
Notes Address Book when you use the Name Look-
Up feature. Lotus Notes Address Book must be
installed and running on your computer.

Public Directory The check box to indicate if Avaya one-X®

Communicator must search for contacts in a public
directory when you use the Name Look-Up feature.
Public Directory must be configured using the Public
Directory settings.

Avaya SIP Personal Profile Manager (PPM)
Contacts (SIP mode only)

The check box to select if you want Avaya one-X®

Communicator to search for contacts in Avaya SIP
Personal Profile Manager (PPM) Contacts when you
use the Name Look-Up feature.

Avaya one-X® Client Enablement Contacts (Avaya
one-X® Client Enablement Services mode only)

The check box to select if you want Avaya one-X®

Communicator to search for contacts in the Avaya
one-X® Client Enablement Contacts directory when
you use the Name Look-Up feature.

Note:

You must use Avaya one-X® Client Enablement
Services account in Login settings to use this
feature
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Field Name Description
Enable wipe-to-dial (clipboard dialing) The check box to enable the Wipe-to-dial feature.
SMS Gateway The administered gateway for sending and receiving

Short Message Service (SMS) transmissions. This is
a read-only field and you can view the gateway only
if your administrator has enabled the service using
the Avaya one-X® Communicator Centralized
Administration Tool.

SMS Prefix The prefix number to be used before the phone
number for sending an SMS. This is a read-only field
and you can view the gateway only if your
administrator has enabled the service using the
Avaya one-X® Communicator Centralized
Administration Tool.

FAX Gateway The administered gateway for sending faxes using
Avaya one-X® Communicator. This is a read-only
field and you can view the gateway only if your
administrator has enabled the service using the
Avaya one-X® Communicator Centralized
Administration Tool.

FAX Prefix The prefix number to be used before the phone
number for sending a FAX. This is a read-only field
and you can view the gateway only if your
administrator has enabled the service using the
Avaya one-X® Communicator Centralized
Administration Tool.

Related links
Configuring desktop integration settings on page 52

Configuring Hot Keys
Procedure

1. Click Hot Keys in the left pane of the General Settings window.

2. Select a hot key from the existing list.

3. In the Press a new shortcut key, enter the keys you want to assign. The hot key must
contain one or more modifier key (Ctrl, Alt, Shift, Win) otherwise it will not be saved and
applied.

4. Select the Global hot key check box, if required.

5. Click OK.

Related links
Hot keys screen field descriptions on page 55
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Hot keys screen field descriptions
Name Description
Name Name of the Hot key. The name also indicates the

function of the Hot key.
Hot key Keys assigned to a particular function.
Press a new shortcut key Shortcut keys that you want to assign it to a function.

A hot key must contain one or more modifier key
(Ctrl, Alt, Shift, Win) otherwise it will not be saved
and applied.

Global Hot key Hot keys that work even when Avaya one-X®

Communicator is not in focus on your computer.
Assign The field to assign Hot keys to a function using a

button.
Remove The field to remove assigned Hot keys from the list

using a button.

Related links
Configuring Hot Keys on page 54

Configuring network settings
About this task
You need to change the default settings on this screen only if you experience problems logging in to
the server in a VPN and/or firewall environment.

Procedure
1. If you installed Avaya one-X® Communicator in H.323 mode, select the Specify local

UDP/TCP port range preference check box to configure Avaya one-X® Communicator for
use with a firewall using UDP port restrictions.

2. If you selected the check box in Step 1, complete the Low and High fields.

3. Select the Use Differentiated Services for Audio check box and enter a DSCP value.

4. Select the Use 802.1p prioritization for Audio check box and enter a Priority value.

5. Click OK.

Network screen field descriptions
Field Name Description
Specify local UDP/TCP port range preference The option to select if you want to specify you port

range preferences.
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Field Name Description
Low Number of the lowest port you want Avaya one-X®

Communicator to use. This number must be greater
than 1023 and less than 65472.

High Number of the highest port you want Avaya one-X®

Communicator to use. This number must be less
than 65536.

Use Differentiated Services for Audio Indicates if differentiated audio services are enabled.
DSCP Specifies DSCP value in the range from 0 to 63.
Use 802.1p prioritization for Audio Indicates of Avaya one-X® Communicator is to use

802.1p prioritization for Audio.
Priority Specifies the priority value in the range of 0 to 7.

Configuring advanced settings
About this task
Using the Diagnostic Logging feature, you can report a problem you are facing and send the log files
to the Avaya one-X® Communicator technical support team. The technical support team uses these
log files to find the cause of the problem.

Procedure
1. Click Advanced in the left pane of the General Settings window.

2. Click Diagnostic Logging.

Avaya one-X® Communicator displays the Diagnostic Logging dialog box.

3. Select the Enable Diagnostic Logging check box.

4. Execute the scenario where you have observed the problem and try to reproduce it.

5. Click Send log files now.

Your default e-mail client opens. The log files are embedded as an attachment in the mail.

6. Enter the e-mail address of the support team, and fill in the following details in the e-mail
message body:

• Description of the problem

• Steps to reproduce the issue

• Frequency of the problem

7. Click OK.
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Advanced screen field descriptions
Field Name Description
Diagnostic Logging Option to send the log files of the technical problems

you are facing to the technical support team using a
button. The technical support team uses these log
files to find the cause of the problem.

Enable Diagnostic Logging Check box to select if you want to enable diagnostic
logging.

Send log files now Option to send the log files to the technical support
team using a button. The log files are sent through
your default e-mail client.
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Chapter 5: Making Calls

Making a call from the main window
About this task
To make a call from the main window:

Procedure
1. In the Enter name or number field, enter the telephone number you want to dial.

To make an international call, prefix your number with "+" sign and then the country code.
For example, you want to make a call to 1234567890 in India. The country code for India is
91. Therefore, you must enter +911234567890. For making calls to numbers with the "+"
sign, you must enable the Apply dialing rules for outgoing calls check box in the Dialing
Rules screen. For more information, see Configuring dialing rules settings on page 43.

2. Click the Place Call icon.

If you are in Other Phone mode, answer the call from the other phone.

A call appearance is displayed for the call. You can view the contact name in the call
appearance.

Making a personal call from the contacts List
Procedure

1. Click the Show Contacts icon to display your contacts.

2. From the View drop-down menu, select the appropriate contact list.

3. For the contact you want to call, click Call > Personal Call and select the number from the
list.

Making a call from the instant messaging window
Apart from using the instant messaging window to send and receive messages, you can also call
the contact from the window.
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Procedure
1. Click the Show Contacts icon to display your contacts.

2. From the View drop-down menu, select Favorites to display your Favorites list.

3. Click the Launch IM icon to view the Instant Messaging window.

4. Click the Call icon at the top of the Instant Messaging window.

Making a call from Microsoft Internet Explorer
If you have installed and configured Avaya Collaboration Services with Avaya one-X®

Communicator, dialable numbers from your Microsoft Internet Explorer Web browser are
highlighted. You can dial these numbers using Avaya one-X® Communicator. Avaya one-X®

Communicator follows the dialing rules set by you to dial the number.

Before you begin
Before you can dial a telephone number from Internet Explorer, you must install and configure
Avaya Collaboration Services.

About this task
Avaya Collaboration Services Web browser Add-in searches the displayed page and highlights the
valid numbers. Avaya Collaboration Services Web Browser Add-in applies enterprise, national, and
international dialing rules to ensure that you can dial highlighted numbers from your Web browser.
To start a call from Microsoft Internet Explorer:

Procedure
1. In the browser window, move the cursor on the highlighted telephone number that you want

to dial.

2. Click Call.

Avaya one-X® Communicator initiates a call to the highlighted number.

Dialing a number from Google Chrome
If you have installed and configured Avaya Collaboration Services with Avaya one-X®

Communicator, dialable numbers from your Chrome Web browser are highlighted. You can dial
these numbers using Avaya one-X® Communicator. Avaya one-X® Communicator follows the dialing
rules set by you to dial the number.

Before you begin
Before you can dial a telephone number from Google Chrome, you must install and configure Avaya
Collaboration Services.

Making a call from Microsoft Internet Explorer
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About this task
Avaya Collaboration Services Web browser Add-in searches the displayed page and highlights the
valid numbers. Avaya Collaboration Services Web Browser Add-in applies enterprise, national, and
international dialing rules to ensure that you can dial highlighted numbers from your Web browser.
To start a call from Google Chrome:

Procedure
1. In the browser window, move the cursor on the highlighted telephone number that you want

to dial. When the cursor is moved on the highlighted telephone number and the number
belongs to a user from the Favorites list the contact card will be shown

2. Click Call.

Avaya one-X® Communicator initiates a call to the highlighted number.

Dialing a number from Mozilla Firefox
If you have installed and configured Avaya Collaboration Services with Avaya one-X®

Communicator, dialable numbers from your Firefox Web browser are highlighted. You can dial these
numbers using Avaya one-X® Communicator. Avaya one-X® Communicator follows the dialing rules
set by you to dial the number.

Before you begin
Before you can dial a telephone number from Mozilla Firefox, you must install and configure Avaya
Collaboration Services.

About this task
Avaya Collaboration Services Web browser Add-in searches the displayed page and highlights the
valid numbers. Avaya Collaboration Services Web Browser Add-in applies enterprise, national, and
international dialing rules to ensure that you can dial highlighted numbers from your Web browser.
To start a call from Mozilla Firefox:

Procedure
1. In the browser window, move the cursor on the highlighted telephone number that you want

to dial. When the cursor is moved on the highlighted telephone number and the number
belongs to a user from the Favorites list the contact card will be shown

2. Click Call.

Avaya one-X® Communicator initiates a call to the highlighted number.
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Using Wipe-to-dial to make a call
Use this feature to dial a phone number from any application on your computer through Avaya one-
X® Communicator.

Before you begin
Ensure that you have enabled the Wipe-to-dial feature from the Preferences dialog box.

About this task
To dial a number:

Procedure
1. Select a phone number in any application on your computer.

2. Right-click the Avaya one-X® Communicator icon on your system tray.

The selected number appears as an option to make a call.

3. Select the phone number to start the call.

A call appearance is displayed for the call.

Making a call using a bridged extension
Your system administrator sets up bridged extensions. With the bridged extension feature, you can
use another extension to make a call from your phone. At the receiving end, the call appears to
have originated from the other extension. Avaya one-X® Communicator displays bridged extensions
in the drop-down list box adjacent to the Enter name or number field.

About this task
To make a call using a Bridged Extension:

Procedure
1. In the drop-down list box adjacent to the Enter name or number field, click the bridged

extension that you want to use for making the call.

2. Click the Place Call icon.

If you are in Other Phone mode, answer the call from the other phone.

A call appearance is displayed for the call.

Using Wipe-to-dial to make a call
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Redialing the last number dialed
About this task
The Redial icon dials the last telephone number that you dialed from Avaya one-X® Communicator
during the current session.

Procedure
Click the Redial icon.

If you are in Other Phone mode, answer the call from the phone. A call appearance is displayed for
the call.

Sending tones during an active call
When you are on an active call in This Computer mode or Desk Phone mode, you can send any
contact number or digits pasted in the search field as tones to the call. You can use this feature to
send tones such as conference codes during a call.

Procedure
1. When you have an active call, perform any one of the following, as appropriate:

• To send a number as a tone, enter the number in the Enter name or number field, and
click the menu button near the Place Call icon.

• To send a contact number as a tone, right-click the contact.

System displays the option to send entered digits or selected contact numbers as tones to
the active call.

2. Click Send Tones.

Entering digits during a call
In This Computer mode use the Dialpad to enter digits during an active call.

Note:

In the Desk Phone mode and the Other Phone mode Avaya one-X® Communicator doesn't
show numbers dialed from a hard phone during an active call.

Procedure
1. Perform any one of the following:

• Press the digits on the keyboard of your computer.
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• Click the Show Dialpad icon to access the Dialpad and click the appropriate digits.

The dialed digits are shown on the call bar. The digits are cleared from the call bar when you
end an active call or put the call on hold.

2. Click X to close the Dialpad.

Making a personal call from the main Window
About this task
To make a personal call from the main window

Procedure
1. In the Enter name or number field, enter the telephone number you want to dial.

2. Click the arrow icon that appears next to the Place Call icon on the Action bar.

The arrow icon appears only if your administrator has activated the Personal Call feature.

3. Select Personal Call.

Making a personal call from call logs
Procedure

1. Click the Show Call Log button to access the Call Log.

2. For the contact you want to call, click the Call button > Personal Call and select the number
from the list.

Making calls from MS Office applications
This feature provides callers with a simple way to make calls using contact information in the
following Microsoft Office applications:

• Microsoft Office Outlook items such as email, contact, calendar, task, journal

• Microsoft Office Word documents

• Microsoft Office Excel spread sheets

• Microsoft Office PowerPoint presentations

Office Add-in highlights telephone numbers with Smart Tags or dotted underlines or both.

Contact your system administrator to ensure this feature is available for your configuration.
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Related links
Making a call from Microsoft Outlook on page 64
Making a call from MS Excel on page 64
Making a call from MS Power Point presentation on page 65

Making a call from Microsoft Outlook
Procedure

1. Open any e-mail in Microsoft Office Outlook.

Office Add-in highlights telephone numbers with Smart Tags or dotted underlines or both.

2. Move the insertion point on the text with a Smart Tag indicator until Smart Tag Actions
appears.

3. Click Smart Tag Actions to open the drop-down menu, and scroll down to Additional
Actions to access the Call functions

4. Click a number to initiate the call.

Smart Tag normalizes the highlighted number into a format based on the default locale
settings of the e-mail.

For example: if the document is originated in the UK, the number is marked and then
normalized to the E.164 format.

Note:

Contact your system administrator to ensure that required rules for Enterprise Dial plan
identification are enabled in Office Add-in..

Related links
Making calls from MS Office applications on page 63

Making a call from MS Excel
Before you begin

Note:
Numbers in the Excel spread sheet cell must be prefixed by a + sign and be in a text format, for
it to be distinct from regular numbers.

Procedure
1. Open an excel spread sheet with telephone numbers and hover your cursor over the

underlined number until the Smart Tag Actions button appears.

2. Click the Smart Tag Actions icon to open the drop-down menu and scroll down to the
Additional Actions option to access the Call functions.
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3. Select a number and initiate the call.

Related links
Making calls from MS Office applications on page 63

Making a call from MS Power Point presentation
Before you begin

Note:
The numbers in Power Point document must be prefixed by a + sign and be in text format, for it
to be distinct from regular numbers

About this task
To make a quick call:

Procedure
1. Open a Power Point document with a telephone number, and hover over an underlined

number until the Smart Tag Actions button appears.

2. Click the Smart Tag Actions icon to open the drop-down menu, and scroll down to the
Additional Actions option to access the Call functions.

3. Select a number and initiate the call.

Related links
Making calls from MS Office applications on page 63
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Chapter 6: Handling Calls

Call overview
Avaya one-X® Communicator provides you voice and video call facility with option to escalate or de-
escalate a voice call to video call and video call to voice call depending on your endpoint. you can
make and handle voice calls without making changes to the settings. However, perform the following
before using Avaya one-X® Communicator for video calls:

• To enable video, select the Enable video calls check box from the Telephony screen. See 
Configuring telephony settings on page 30.

• Select a preferred camera. See Selecting preferred camera on page 19.
• Enable sending your video image automatically. See Configuring video settings on page 46. If

you enable this feature, Avaya one-X® Communicator initiates all your calls as video calls.

For more information on video calls, see Using video with Avaya one-X Communicator on page 72.

Answering a call
About this task
When you receive a call, Avaya one-X® Communicator displays an incoming call in the call
appearance area. After you answer the call, the active call timer starts. The active call timer keeps
track of the duration of the call. If you are part of a call pickup group, the system displays the calls
and call pickup related information when any member in the pick up group has an incoming call.

Procedure
Click the Accept icon for the incoming call or press the keyboard shortcuts assigned for answering
a call.

If you are in Other Phone mode, answer the call from the other phone.

Hanging up a call
Procedure
Click the Hang Up icon for the call or press the keyboard shortcuts assigned for ending a call.
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Rejecting an incoming call
Use this procedure to reject an incoming call.

Procedure
To ignore an incoming call, click the Reject icon for the call.

Blocking and unblocking calls
Use this feature to block or allow all incoming calls on your Avaya one-X® Communicator. The
feature is available when you integrate Avaya one-X® Communicator with Avaya one-X® Client
Enablement Services .

Procedure
1. Click the Mode settings icon on the Avaya one-X® Communicator user interface.

2. From the Block Calls drop-down menu, select Block all calls.

After you select this option, Avaya one-X® Communicator does not receive or display any
incoming calls.

Next steps
To allow calls, select Do not block from the drop-down menu.

Allowing only VIP calls
Use this feature to allow incoming calls only from VIP contacts. Avaya one-X® Communicator blocks
all other incoming calls when you use this feature. The feature is available when you integrate
Avaya one-X® Communicator with Avaya one-X® Client Enablement Services. For more information
on VIP contacts, see Marking a contact as a VIP on page 104.

Procedure
1. Click the Mode settings icon on the Avaya one-X® Communicator user interface.

2. From the Block Calls drop-down menu, select Allow VIP calls.

Viewing the call details (H.323 mode)
Line display information feature is supported in Avaya one-X® Communicator only with H.323
protocol.
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About this task
Use this procedure to set Avaya one-X® Communicator to display call information for the active call.
The line display information appears below the call appearance area in the Avaya one-X®

Communicator window.
To view the line display information for the active call:

Procedure
1. Click the Menu icon.

2. Select View > Show Line Display.

Muting the microphone
About this task
You can mute or unmute the microphone only in This Computer user mode. When you mute the
microphone, your microphone is muted for all calls. To use your microphone, you must unmute the
microphone.

Procedure
Click the Mute icon.

If you need to unmute the call, click the Unmute icon.

Transferring a call to another number
About this task
Use the following procedure when you are active on a call and want to transfer the call to another
number.

Procedure
1. While you are active on a call, click the Transfer icon to open the Transfer dialog box.

2. In the To field, enter the number to which you want to transfer the call.

3. Click OK.

The call disappears from the Avaya one-X® Communicator window, indicating that the
transfer was successful.

Note:

You can also transfer a call to another number by dragging and dropping the call
appearance to either an entry in the call log or to a contact, and then clicking the
Transfer icon that appears on the respective call log entry or the contact entry.
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Transferring a call to another active call
About this task
Use the following procedure when you are active on one call and another call is on hold, and you
want to transfer one of the calls to another call or to another number.

Procedure
1. While you are active on a call, click the Transfer icon

The Transfer dialog box appears. By default, the To field displays the number of the other
call, which is on hold.

2. Perform one of the following:

• If you want to transfer the call to the other call, which is on hold, click Transfer. The call
disappears from the Avaya one-X® Communicator window, indicating that the transfer was
successful.

• If you want to transfer the call to another number, click Other Number.
3. In the To field, enter the number to which you want to transfer the call.

4. Click OK.

The call disappears from the Avaya one-X® Communicator window, indicating that the
transfer was successful.

Note:

You can also transfer a call to another number by dragging and dropping the call
appearance to either the held call appearance, or to an entry in the call log, or to a
contact, and then clicking the Transfer icon that appears in the held call appearance, or
the respective call log entry, or the contact entry.

Placing a call on hold
When you place a call on hold, the hold timer starts. The hold timer keeps track of how long the call
is on hold. The hold timer restarts every time the call is placed on hold.

About this task
To place a call on hold:

Procedure
Click the Hold icon for the active call.

The call is placed on hold.

If the call is video enabled, Avaya one-X® Communicator stops sending video to the other party.
When you resume the call, Avaya one-X® Communicator resumes sending video to the other party.

Transferring a call to another active call
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Resuming a call on hold
About this task
When you resume a call that is on hold, the active timer resumes.

Procedure
Click the Resume icon for the held call.

If the call is video enabled, Avaya one-X® Communicator resumes sending video to the other party.

Turning off ringing for all incoming calls
About this task
To turn off ringing for all incoming calls, perform the following steps:

Procedure
1. Click the Menu icon and select Settings > General Settings .

The General Settings dialog box appears.

2. Click Audio to open the Audio page.

3. Clear the Ring on incoming calls check box.

4. Click OK.

Call confirmation dialog box
The Call Confirmation dialog prompts you to confirm that you want Avaya one-X® Communicator to
dial the displayed number. Click OK to dial the number.

Dialpad
The Dialpad dialog box displays the digits that are on a telephone dial pad and the feature buttons
administered for your extension. Use the Dialpad to:

• Click the digits you want to dial (You can also dial the digits using the keyboard of your
computer)

• Use the feature buttons
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Procedure
1. To access the Dialpad, click the Dialpad icon.

2. To hide the Dialpad, click the Dialpad icon again.

Alternatively, you can click the X button available at the top right corner of the Dialpad dialog
box.

Dialpad
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Chapter 7: Handling Video Calls

Using video with Avaya one-X® Communicator
For video calls, ensure that the Enable Video Calls check box in the General Settings window is
selected.
Using the video integration feature, you can make and handle video calls using Avaya one-X®

Communicator if the media server of your enterprise provides support and is configured for video.
Avaya one-X® Communicator attempts to "register" with the video feature on the media server.

Note:
The Video icon  is displayed for users that avail IM and Presence services and are added as
Favorites.

When video is available during a call, you can:
• Send video to the other party.
• Receive video from the other party.
• Mute video (temporarily stop sending video to the other party) on page 75.
• Stop the video on page 75.
• View statistics for the call on page 75.
• View full screen video on page 77.
• Keep video window always on top on page 74.

By default, Avaya one-X® Communicator sends your video image automatically when you answer or
join a video call. To change this setting, see Changing your video settings on page 73.

Opening the Video Window
Use this procedure to open the video window if it is closed.

Procedure
1. Click the Menu icon and select Settings > General Settings > Video.

2. Click Open Video Window.
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Setting the video window to appear automatically on login
Procedure

1. Click the Menu icon and select Settings > General Settings.

The General Settings window appears.

2. Click Video.

3. Click Advanced.

4. Make sure the Show the video window automatically on login with video capabilities
check box is selected.

5. Click OK.

Displaying the video window in optimal size
Procedure
Click the Video Optimize Window icon in the video window.

Changing your video settings
About this task
To change your video settings:

Procedure
1. Click the Menu icon and select Settings > General Settings.

The General Settings window appears.

2. Click Video.

You can change the following video settings:

• Whether to start sending your video images automatically when you answer or join a call

• Whether to display the near-end video and the far-end video in the same window (Picture-
in-Picture)

• Whether to make the video picture to stretch to fit the screen in full-screen mode

• Whether to enable the screen saver and monitor power saving mode during a call

3. If you want Avaya one-X® Communicator to start sending your video image automatically,
make sure the Send your video image automatically when you answer or join a video
call check box is selected.

Setting the video window to appear automatically on login
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Note:

If you disable this setting, Avaya one-X® Communicator does not send the video
automatically when you answer or join a video call. The Video Umute icon is displayed.
To start sending video to the other party on the call, you must click the Video Umute
icon.

4. To set Avaya one-X® Communicator to display the near-end and far-end video in the same
window, perform the following steps:

a. Select the Display a picture-in-picture window check box.

b. Select the appropriate option for the size of the picture-in-picture window (that is, small,
medium, or large).

c. If you want the picture-in-picture window to remain in a fixed location in the video
window, select the Fixed picture-in-picture location check box.

5. If you want Avaya one-X® Communicator to stretch the video window to fit the screen on a
full screen video mode, select the Stretch video to fit screen check box.

6. If you want Avaya one-X® Communicator to display a warning before displaying the video
window on a full screen mode, select the Display warning before entering Full Screen
mode check box.

7. If you want to disable the screen saver and do not want the monitor to switch to the power
saving mode during an active video call, select the Automatically disable screen saver
and monitor power saving mode during a call check box.

8. Click OK.

Viewing video in Picture in Picture (PIP) mode
About this task
Use this procedure to view your video picture and the video picture of the called party in PIP mode
in your video window:

Procedure
1. Select the Display a picture-in-picture window check box, see Changing your video

settings on page 73.

2. Ensure that the video window is open on your end and the other party's window.

3. Click the Place Call icon.

Two pictures appear in the video window.
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Muting the Video
Use this procedure to temporarily stop sending video to the other party during a call.

Procedure
1. Click the Video Mute icon.

Avaya one-X® Communicator stops sending the video. However, you continue to receive
video from the other party. The other party sees the following message in their video window:
"Far End Muted."

2. To resume sending video to the other party, click the Video Active: click to mute icon.

Stopping the video
About this task
Use this procedure to stop the video call and continue the call only in audio mode. Stopping the
video during a call does not disconnect the call.

Procedure
During an active video call, click the Stop Video icon.

If an Avaya one-X® Communicator user stops a SIP video call, the video call window at the far-end
user closes. However, if an Avaya one-X® Communicator user stops an H.323 video call, the video
call window at the far-end user does not close . The far-end user sees a black video window.

Viewing the statistics for a video call
Procedure

1. Click the Menu icon and select Settings > Statistics > Video.

2. In the Video window, click the Menu icon and select Video Statistics.

The Video Statistics dialog box appears.

Parameter Name Description
Video Information

Camera Name of the camera supporting the call
Destination Address IP address of the destination that is receiving the

voice and video packets.
Resolution Resolution of the video call

Table continues…
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Parameter Name Description
Local Encryption The field indicates if the video call is encrypted

locally.
Traffic Status of the video traffic (for example, receive

only, transmit only, or receive and transmit both)
Transmit and Receive Statistics

Bit Rate Rate at which data in a video is being processed
and streamed. Bit rate is measured in kilobits per
second (kbps).

Frame Rate Number of displayed frames per second
Jitter Displays the size of the jitter buffer, which stores

packets to ensure a consistent delivery of video
to your system, so the video you see does not
contain gaps. The larger the jitter buffer, the
longer the delay in receiving video from the other
party.

Packet Loss Displays the number of video packets lost during
the transfer

Quality The level of video quality for the current call
Rx Shows statistics of the called party
Tx Shows statistics of the calling party

3. When finished, click Close.

Video statistics window
When a call is in progress, you can view the following statistics in the Video Statistics window:

Video Information
Parameter name Description
Camera Name of the camera supporting the call.
Destination Address IP address of the destination that is receiving the

voice and video packets.
Resolution Resolution of the video call.
Local Encryption Indicates if the video call is encrypted locally.
Traffic Status of the video traffic (for example, receive only,

transmit only, or receive and transmit both)

Handling Video Calls

November 2015 Using Avaya one-X® Communicator 76
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya one-X® Communicator


Transmit and Receive Statistics
Parameter name Description
Bit Rate Rate at which data in a video is being processed and

streamed. Bit rate is measured in kilobits per second
(kbps).

Frame Rate Number of displayed frames per second
Jitter Displays the size of the jitter buffer, which stores

packets to ensure a consistent delivery of video to
your system, so the video you see does not contain
gaps. The larger the jitter buffer, the longer the delay
in receiving video from the other party.

Packet Loss Displays the number of video packets lost during the
transfer

Quality The level of video quality for the current call.
Rx Shows statistics of the called party.
Tx Shows statistics of the calling party.

Viewing full screen video window
Procedure

1. Click the Full Video Window icon on the video window to open the full screen video.

You get a warning that you can press the Escape key anytime to return to normal mode.

2. Select the Do not display this warning in future check box, if you do not want to see this
warning next time.

3. Press the Escape key to return to the normal mode from the full screen mode.

Keeping the video window always on top
About this task
To keep the video window always on top of other applications:

Procedure
1. Click the Menu icon in the video window.

2. Click Settings > General Settings and select Video.

3. Click Open Video Window.

4. Click the Menu icon and select the Always on Top option.

Viewing full screen video window
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Video - General tab
Enables you to configure the following video options:

• whether you want video calls to start automatically
• whether you want Avaya one-X® Communicator to display the near-end video and the far-end

video in the same window (Picture-in-Picture) or in individual windows
• whether video window should stretch to fit the screen
• enable or disable screen saver and monitor power saving mode during a call

Video option Description
Open Video Window Click this icon to open your video window (if it is

closed).
Send your video image automatically when you
answer or join a video call

Select this check box if you want Avaya one-X®

Communicator to send your video image
automatically when you answer or join a video call.

Use PIP Settings to configure the picture-in-picture settings
Display a picture-in-picture window Select this check box if you want to view the near-

end video and the far-end video in the same window.
Small picture-in-picture window Select this option if you want Avaya one-X®

Communicator to provide a small picture-in-picture
window.

Medium picture-in-picture window Select this option if you want Avaya one-X®

Communicator to provide a medium size picture-in-
picture window.

Large picture-in-picture window Select this option if you want Avaya one-X®

Communicator to provide a large picture-in-picture
window.

Fixed picture-in-picture window location Select this check box if you want Avaya one-X®

Communicator to display the picture-in-picture
window in a fixed location.

Full Screen Video
Stretch video to fit screen Select this check box if you want the video window to

stretch to fit the screen on a full screen video mode.
This may make the image look a little distorted.

Display warning before entering Full Screen
mode

Select this check box if you want Avaya one-X®

Communicator to display a warning when you click
the  icon on the video window to display the
video window in the full screen mode.

Screen Saver and Monitor Power Saving Automatically disable screen saver and monitor
power saving mode during a call.

Table continues…
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Select this check box if you do not want:

• the screen saver to become active during an active
video call.

• the monitor to switch to the power saving mode
during an active video call.

Video - Administration tab
Enables you to optimize your video codec selection for each call.

Codec Preferences
Select the check box corresponding to the listed codec. The codecs available for selection are:

• H.263
• H.263-1998
• H.264

Video - Advanced tab
Enables you to configure the following video options:

• the camera you want to use

• whether you want to manually release/acquire the camera

• maximum bit rate for video calls

• performance

• whether you want the video window to appear in the optimal size supported by the graphics
card in your computer. Optimizing the video window may decrease CPU usage on your
computer and increase performance.

Setting Description
Preferred Camera Select the camera you want to use.
User Session Maximum Bit Rate Select the maximum bit rate for each video call you

make or receive with Avaya one-X® Communicator.
Optimize Video Window Size Select the Optimize button if you want the video

window to appear in the optimal size supported by
the graphics card in your computer. Optimizing the
video window may decrease CPU usage on your
computer and increase performance.

Table continues…
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Setting Description
Show the video window automatically on login
with video capabilities

Select this check box if you want the video window to
appear automatically when you log into the server.

Video window
Video window displays the near-end and far-end video for your call.

From this window, you can do the following:
• Stop sending video to the other party for the remainder of the call on page 75
• View statistics for a call on page 75
• Display video in optimal size on page 73
• View full screen video on page 77
• Keep video always on top on page 77

Video statistics signalling window
The Signalling window displays the signaling information (transmit and receive) for the current video
call.

Transmit and Receive Statistics
Parameter name Description
Bit Rate Rate at which data in a video is being processed and

streamed. Bit rate is measured in kilobits per second
(kbps).

Frame Rate Number of displayed frames per second
Jitter Displays the size of the jitter buffer, which stores

packets to ensure a consistent delivery of video to
your system, so the video you see does not contain
gaps. The larger the jitter buffer, the longer the delay
in receiving video from the other party.

Packet Loss Displays the number of video packets lost during the
transfer

Quality The level of video quality for the current call
Rx Shows statistics of the called party
Tx Shows statistics of the calling party
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Video statistics capabilities window
The Capabilities window displays the supported Codecs.

Video statistics capabilities window
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Chapter 8: Handling Conference Calls

Starting a conference
About this task
Depending on the telephone system in use, up to six participants (including the chairperson) can
join a conference. To start a conference, at least one call should be active in the Avaya one-X®

Communicator window.
To start a conference:

Procedure
1. Make sure there is at least one active call in the Avaya one-X® Communicator window.

2. Click Conference to open Conference dialog box.

3. In the With field, enter the contact number to join to the conference call.

4. Click OK.

The dialed number gets connected to the conference call.

Note:

Even if the connection to the server is lost, Avaya one-X® Communicator still support a
local conference for 3-6 parties.

Adding a Participant to a conference
About this task
Depending on your telephone system, you may have up to six participants (including yourself) in a
conference.

Procedure
1. Perform one of the following :

• Call the party you want to add to the conference.

• Answer the call from the party you want to add to the conference.

2. Click Conference.

November 2015 Using Avaya one-X® Communicator 82
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya one-X® Communicator


The Conference dialog box appears.

3. Click Conference for the party you want to add to the conference or by drag and drop the
party in the Conference dialog box and then click Conference.

Placing a conference on hold
Procedure
Click the Hold icon to place a conference on hold.

Resuming a conference on hold
Procedure
Click the Unhold icon to resume a conference that is on hold.

Hanging up a conference
About this task
To end a conference call:

Procedure
Click the Hang Up icon for the active conference call.

Ending the last call from a conference
Use this procedure to end the last call that was added to the conference.

Before you begin
The conference must be active when you want to drop the last call.

About this task
To end the last call from a conference:

Procedure
Click Drop for the active conference call.

Avaya one-X® Communicator disconnects the last call that you made.

Placing a conference on hold
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Adding Personal Calls to a Conference
About this task
Before you can start a conference between Personal calls you must initiate separate calls to the
required parties and then add them to a conference. To add Personal calls to a conference, perform
the following steps:

Procedure
1. Perform a Personal call to the first party you want to add to the conference. Refer to Making

a personal call from the main window on page 63 for details.

2. Perform a new Personal call to the other party you want to add to the conference.

3. Click Conference.

Conference dialog box
Use the Conference dialog box to:

• Start a new conference

• Add a participant to a conference

To add a call to a conference, click Conference.
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Chapter 9: Using Bridge Conferencing

Calling into a bridge conference
About this task

Note:
The Bridge Conference icon is available only when Avaya one-X® Communicator is integrated
with Avaya one-X® Client Enablement Services.
To call into a bridge conference, perform the following steps:

Procedure
1. Click the Bridge Conference button to open the Bridge Conference window.

2. Enter the conference bridge number in the box, and click the Place Call button.

3. Use the Avaya one-X® Communicator Dialpad to enter the access code and log into the
bridge.

The Bridge Conference window displays the conference participants. The default name that
Avaya Meeting Exchange™ assigns to each conference appears at the top of the window.
Your information is displayed in bold type at the top of the participants list.

Related links
Bridge Conference window on page 85

Bridge Conference window
Enables you to call into a bridge conference and view the participants in the bridge conference. The
actions you can perform from this window depend on your whether you are a host or a participant.

If you are a conference host (that is, you enter the host login code), you can:

• add new participants

• mute the entire conference or individual participants

• lock the conference to prevent new participants from dialing in

If you are a conference participant (that is, you enter the participant login code), you can:

• mute yourself
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• put yourself on hold

• drop yourself from the conference

Related links
Calling into a bridge conference on page 85

Host tasks for bridge conferencing

Using Click to Join or Host a conference call feature
Click to Join or Host a conference call feature allows launching a conference call and / or a web
collaboration session. The Office Add-in will determine if the user is the Host or a Participant to this
call, and use the appropriate access passwords to access this call.

Before you begin
Note:
On entering Outlook for the first time after the Office Add-in is installed, a Conference Bridge
Wizard will be launched. It will scan the users existing meetings and extract the conference
details needed to join the meeting invitations

Procedure
1. To join or host a conference, perform one of the following:

• Open the Microsoft Outlook meeting reminder and click the Join Conference icon in the
meeting window bar, and select the bridge number.

• Right-click the meeting in the Outlook Calendar > select Host Conference > click the
bridge number.

2. To open the Web Collaboration, run one of the following:

• Open the Microsoft Outlook meeting reminder and click the Join Conference button in the
meeting window bar, and select the Launch Web Collaboration option

• OR right-click the meeting in the Outlook Calendar > select Host Conference > click
Launch Web Collaboration.

Web collaboration window will open.

Next steps
To create a meeting invitation using the Click to Join or Host a conference call feature, add a new
meeting invitation in the MS Outlook and add the bridge details to the meeting Location field by
clicking the Add Conference Details button.

Using Bridge Conferencing
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Locking or unlocking a bridge conference
If you are logged in as a host, you can lock the bridge conference to new participants so that no new
participants can join until you unlock the conference.

About this task
To lock the bridge conference:

Procedure
1. In the Bridge Conference window, click the Bridge Conference Lock icon.

The conference Security icon appears at the top of the window.

2. To unlock the bridge conference click the Bridge Conference Unlock icon in the Bridge
Conference window.

Muting a bridge conference (Lecture mode)
If you are logged in as a host, you can mute all other lines in the bridge conference. In this mode,
the participants can only listen.

About this task
To put the bridge conference on the lecture mode, perform the following step:

Procedure
In the Bridge Conference window, click the Bridge Conference Lecture On icon.

Unmuting a bridge conference
Procedure
In the Bridge Conference window, click the Bridge Conference Lecture Off button.

Muting a participant
If you are logged in as a host, you can mute a participant.

About this task
To mute a participant:

Procedure
In the Bridge Conference window, click the Mute button for the participant you want to mute.

An icon appears for the selected participant indicating that the participant is muted.

Host tasks for bridge conferencing
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Unmuting a participant
Procedure
In the Bridge Conference window, click the Unmute button.

Placing a bridge conference on hold
If you are logged in as a host, you can place the bridge conference on music hold.

About this task
To place a bridge conference on hold:

Procedure
In the Bridge Conference window, click the Bridge Conference Hold button.

Resuming a bridge conference on hold
Procedure
In the Bridge Conference window, click the Resume button.

Placing a participant on hold
If you are logged in as a host, you can place a participant on hold.

About this task
To place a participant on hold:

Procedure
In the Bridge Conference window, click the Menu button and select Hold for the participant you
want to place on hold.

An icon appears for the selected participant indicating that the participant is on hold.

Retrieving a participant from hold
About this task
If you are logged in as a host, you can retrieve a participant who is on hold.

Using Bridge Conferencing

November 2015 Using Avaya one-X® Communicator 88
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya one-X® Communicator


Procedure
1. In the Bridge Conference window, click the Menu button.

2. Select Unhold for the participant who is on hold.

Renaming a bridge conference
About this task
Avaya one-X® Communicator uses the default name that Avaya Meeting Exchange™ assigns to
each conference. If you are logged in as a host, you can change the name that is displayed to the
participants for the bridge conference.

Procedure
1. In the Bridge Conference window, click on the conference name at the top of the window.

2. Make your changes.

Sorting participants in a bridge conference
About this task
Regardless of how you sort the participants in a conference, your name is always listed on top in
bold type. The timer is also displayed next to your name.
To sort participants in a bridge conference, run the following steps:

Procedure
1. In the Bridge Conference window, click the Menu button and select Sort Participants by.

2. Select one of the following sorting options:

• Click Name to sort the participants by name.

• Click Join Order to sort by the order in which the participants joined the conference.

• Click Ascending to sort the participants in an ascending order.

• Click Descending to sort the participants in a descending order.

Adding a Participant to a conference
About this task
Depending on your telephone system, you may have up to six participants (including yourself) in a
conference.

Host tasks for bridge conferencing
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Procedure
1. Perform one of the following :

• Call the party you want to add to the conference.

• Answer the call from the party you want to add to the conference.

2. Click Conference.

The Conference dialog box appears.

3. Click Conference for the party you want to add to the conference or by drag and drop the
party in the Conference dialog box and then click Conference.

Dropping a participant from a bridge conference
If you are logged in as a host, you can drop participants from the bridge conference.

About this task
To drop a participant from the bridge conference:

Procedure
1. In the Bridge Conference window, click the Menu button for the participant you want to drop.

2. Select Remove from Conference.

The participant is dropped from the bridge conference.

Ending a Bridge Conference Call
If you logged into the bridge conference as a host, depending on your bridge configuration, you can
drop the bridge conference after making changes even if other hosts remain in the conference.
When the bridge conference ends, all conference participants are dropped.

About this task
To end a bridge conference:

Procedure
In the Bridge Conference window, click the Bridge Conference End button.

Using Bridge Conferencing
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Participant taks for bridge conferencing

Leaving a bridge conference
About this task
Use this procedure to leave a bridge conference that you logged into as a participant. To leave a
bridge conference:

Procedure
1. In the Bridge Conference window, click the Menu icon for your entry.

2. Select Exit Conference.

Unmuting your bridge conference line
About this task
If you are logged into a bridge conference as a participant, use this task to unmute your line in the
bridge conference.

Procedure
In the Bridge Conference window, click the Unmute icon for your entry in the bridge conference.

Muting your bridge conference line
If you logged into a bridge conference as a participant, use this task to mute your line in the bridge
conference.

About this task
To put your bridge conference line on mute:

Procedure
In the Bridge Conference window, click the Mute icon for your entry in the bridge conference.

An icon appears for your entry indicating that you are muted.

Participant taks for bridge conferencing
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Chapter 10: Using Contacts

Contacts overview
The Contacts screen displays your contacts. In standalone mode, you can choose to view All, My
Contacts, and Search Results. When Avaya one-X® Communicator integrates with Avaya one-X®

Client Enablement Services, you can choose to view All, My Contacts, VIP, Favorites, and Search
Results.

From the Contacts screen, you can:

• View the presence status of a Favorite contact and set your presence status.

Presence State Description
When you select presence state Automatic, Avaya
one-X® Communicator automatically changes your
presence according to your current status. For
example, if you make or answer a call, your
presence status automatically changes to On a
call.
Available

Away

Busy

Do not disturb

Out of office

Offline

On a call

Note:

If the contact status is unknown no icon is shown against the contact.

• View the presence note of a contact.

• Add, modify, or delete a contact.

• Search for a contact.
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• View the details of a contact.

• Make a call to a contact.

• Send an e-mail to a contact.

• Send an instant message to a Favorite contact.

• View the video status of a contact.

• Sort contacts by first name or last name.

You can add a maximum of 250 contacts in SIP mode and 1000 contacts in H.323 mode. Avaya
one-X® Communicator displays an error message if you try to add more contacts. The default limit
for adding Favorite contacts is 50 but your administrator can enhance this limit up to 100. For more
on Favorite contacts, see Favorite contacts on page 102.

Adding a contact
About this task
Use this procedure to add a contact to your contacts list.

Procedure
1. Click the Show Contacts icon to display your contacts.

2. Click the Menu icon and select Contacts > Add Contact.

The Add Contact dialog box appears.

3. Enter appropriate information for this contact.

Note:

You should always enter a E.164 handle to the contact located on different
Communication Manager servers, otherwise you can't see its presence status or
exchange instant messages with it.

4. When finished, click OK.

Example
For SIP protocol:

• Contacts that are added when Avaya one-X® Communicator is integrated with Avaya one-X®

Client Enablement Services can also be used in the standalone mode of Avaya one-X®

Communicator.
• However, contacts added in the standalone mode of Avaya one-X® Communicator cannot be

viewed or used when you integrate Avaya one-X® Communicator with Avaya one-X® Client
Enablement Services.

Adding a contact
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Modifying a contact
About this task
To modify the details of a contact:

Procedure
1. Click the Show Contacts icon to display your contacts.

2. Double-click the contact you want to modify.

The Contact Details dialog box displays the information for the selected contact.

3. Make changes to the contact details as required.

4. When finished, click OK.

Deleting contacts
About this task
To delete contacts:

Procedure
1. Click the Show Contacts icon to display your contacts.

2. Select the contacts you want to delete.

3. Right-click and select Delete Selected from Contacts.

A dialog box prompts you to confirm your action.

4. Click Yes.

The selected contacts are deleted.

Viewing contact details
Procedure

1. Click the Show Contacts icon to display your contacts.

2. Find the concerned contact.

3. For the selected contact, perform either one of the following:

• Click the Menu icon, and select Show Details.

• Right-click the contact and select Show Details;

• Double-click the contact.

Using Contacts
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From the Contact Details dialog box, you can:

• View the presence information of the selected contact (only if it has been added as
Favorite).

• View the status message of the selected contact.

• Modify the selected contact details.

• Make a call to the selected contact.

• Send an e-mail to the selected contact.

• Send an instant message to the selected contact (only if it has been added as Favorite).

• View the video status of the selected contact.

4. Perform a required action or click OK to close the dialog box.

Sending an email to a contact
About this task
To send an email to a contact, perform the following actions:

Procedure
1. Click the Show Contacts icon to display your contacts.

2. From the View drop-down menu, select the appropriate contact list.

3. Select a contact and click the Email icon.

The default email application opens with the email address of the contact in the To field.

4. Compose and send your email message.

Sending a Fax or SMS to a contact
About this task
To send a fax or a short message service (SMS) to a contact, perform the following actions:

Procedure
1. Click the Show Contacts icon to display your contacts.

2. From the View drop-down menu, select the appropriate contact list.

3. Select a contact and click the Email icon.

System displays the SMS or Fax addresses if the services are available for the selected
contact.

Sending an email to a contact
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4. Select an option from the drop-down menu.

The default email application opens with the Fax or SMS address of the contact in the To
field.

5. Compose and send your message.

Importing and exporting contacts

Importing Contacts from Microsoft Outlook
Use this procedure to import contacts from Microsoft Outlook to your Avaya one-X® Communicator
contacts list. You can import a maximum of 250 contacts in SIP mode and 1000 contacts in H.323
mode.

Before you begin
• Ensure that you have selected Microsoft Outlook Contacts for Name Look-Up. For the

procedure, see Configuring preferences settings on page 50.
• Ensure that you are using any of the following Microsoft Outlook versions and the e-mail client

is open:
• Outlook 2007 SP1
• Outlook 2007 SP2
• Outlook 2010
• Outlook 2013

About this task
To import contacts from Microsoft Outlook:

Procedure
1. Click the Contacts icon to display your contacts.

2. Click the Menu icon and select Contacts > Import Contacts from Microsoft Outlook.

Microsoft Outlook prompts you to Allow or Deny access to e-mail address information.

3. Select the time duration for access from the Allow access for drop-down menu.

The time duration can be between 1 minute to 10 minutes.

4. Click Allow.

Avaya one-X® Communicator displays the imported contacts in the contacts list. If the
parameters in any of the fields for a contact in Outlook matches with the parameters for a
contact in Avaya one-X® Communicator, the contact does not get imported. Sometimes,
importing a contact from Outlook takes several minutes.

Using Contacts
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Importing contacts
Use this procedure to import contacts that are saved in vCard (.vcf) format to your Avaya one-X®

Communicator Contacts list. This feature is available only in H.323 mode.

Procedure
1. Click the Contacts icon to display your contacts.

2. Click the Menu icon and select Contacts > Import Contacts.

3. Browse to the location where the contacts file (.vcf) is stored and select the file. When
finished, click Open.

The existing contacts in the contacts file (.vcf) get added to Avaya one-X® Communicator
contacts. However, if any information of a contact you want to import matches the
information of an existing contact in Avaya one-X® Communicator, system identifies the
contact as a duplicate contact and does not add the contact to My contact list.

4. On the Contacts Notification dialog box, click OK.

Exporting contacts
Use this procedure to export contacts from your Avaya one-X® Communicator Contacts list to your
computer. The exported contacts are saved in vCard (.vcf) format. You can import these contacts
back to Avaya one-X® Communicator using Importing Contacts procedure, see Importing
contacts on page 97.

Note:

You can export or import contacts in VCard (.vcf format) only when you are using Avaya one-X®

Communicator with H.323 protocol.

Procedure
1. Click the Contacts icon to display your contacts.

2. Click the Menu icon, and select Contacts > Export.
3. Browse to the location where you want to save the contacts file (.vcf).

4. Enter the file name and click Save.

The existing contacts in the contacts file (.vcf) gets saved at the selected location.

5. On the Contacts Notification dialog box, click OK.

Importing and exporting contacts
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Searching for a contact

Searching a contact (SIP mode)
About this task
When you search for a contact, Avaya one-X® Communicator searches the contacts in all Personal
Contacts, Favorites, enterprise contacts, and Search Results.

Procedure
1. Click the Show Contacts icon to display your contacts.

2. In the Enter name or number, enter the name you want to find.

3. Click the Search icon to start searching.

The View drop-down menu displays contacts that match your search criteria in Search
Results.

Note:
• When you enter the first few characters of an enterprise contact’s first name or last

name, all matching names are displayed in the search results. As you type in more
characters, the search results filter to match the new characters. These search results
are populated from your Microsoft Outlook, IBM Lotus Notes, Avaya SIP Personal
Profile Manager (PPM), and Public Directory only if you have selected either or all of
these in the Desktop Integration - General Settings dialog box. However, the search
results are not populated when you type a few characters of first name and last name
under My Contacts.

• If you have configured Novell directory as a Public Directory, you can search a Novell
directory enterprise contact only if you are an authenticated user.

• If you have integrated Avaya one-X® Communicator with Lotus Notes, Lotus Notes
prompts you for a password when you search for an enterprise contact. Enter your
Lotus Notes password to continue the search.

Searching a contact (H.323 mode)
About this task
When you search a contact, Avaya one-X® Communicator , in standalone mode, searches the
contact in:

• All Contacts
• My Contacts
• Enterprise Contacts

Using Contacts
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Avaya one-X® Communicator when integrated with Avaya one-X® Client Enablement Services,
searches contacts in:

• All Contacts
• My Contacts
• Enterprise Contacts
• Favorites
• VIP contacts

Avaya one-X® Client Enablement Services.

Procedure
1. Click the Show Contacts icon to display your contacts.

2. In the Enter name or number box, enter the name or telephone number you want to find.

3. Click the Search icon.

The View drop-down list displays contacts that match your search criteria in Search Results.

Note:
• When you enter the first few characters of an enterprise contact’s first name or last

name, all matching names are displayed in the search results. As you type in more
characters, the search results filter to match the new characters. These search results
are populated from your Microsoft Outlook, IBM Lotus Notes, and Public Directory
only if you have selected either or all of these in the Preferences - General Settings
dialog box.

• If you have configured Novell directory as a Public Directory, you can search a Novell
directory enterprise contact only if you are an authenticated user.

• If you have integrated Avaya one-X® Communicator with Lotus Notes, Lotus Notes
prompts you for a password when you search for an enterprise contact. Enter your
Lotus Notes password to continue the search.

Organizing search results
About this task
Use the Field Organizer dialog box to organize search results after searching contacts.

Button Description
Moves an entry from Available fields to Show in this
order window.
Moves an entry from Show in this order to Available
fields window.

Table continues…
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Changes the order by moving each entry one step
upwards within the list
Changes the order by moving each entry one step
downwards within the list

Procedure
1. Click Field Organizer to open the Field Organizer dialog box for the selected directory type.

2. Select a field from the Available fields.

3. Click the Move Right icon to move the selected field under Show in this order.

Click the Move Left icon to move the field back to Available fields.

4. To change the order of the fields, select the field listed under Show in this order and click the
Up Field icon or the Down Field icon to move the field up or down respectively.

5. Click Save.

The selected fields are displayed in the selected order in the Advanced Search dialog box.

Using advanced search
About this task
Use this feature to search for contacts in a specific directory.

Procedure
1. Click the Show Contacts icon to display your contacts.

2. Click Advanced Search.

3. From the Search drop-down menu, select the directory type.

4. From the Field drop-down menu, select the name of a field by which you are making the
search.

5. Enter a search criteria in the box adjacent to the Field drop-down menu.

6. Click Search.

The contacts that match the criteria are listed in the Search Results.

Note:
• If Novell directory is configured as a Public Directory, you can search a Novell

directory enterprise contact only if you are an authenticated user.

• If Avaya one-X® Communicator is configured with Lotus Notes, Lotus Notes prompts
you for a password when you search for an enterprise contact. Enter your Lotus Notes
password to continue the search.
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Sorting contacts
About this task
Contacts can be sorted by first name or last name, and type.

Procedure
1. From the Sort drop-down list, select First Name or Last Name.

2. Click the Name box to display the names in an ascending or descending order

Advanced Search dialog box
Use the Advanced Search dialog box to search for contacts in a specific directory and organise the
search results.

Field Name Description
Field Type of field. The available options are:

• Last Name

• First Name

• Work Number

• IM Address

• City

• Email Address

• Department

• Mobile Number

• Home Number

• Display Name
Search The field to enter a search criteria.
Field Organizer The field to organize the search results. For more

information, see Field organizer dialog box on
page 101.

Field Organizer dialog Box
You can use Field Organizer dialog box to organize the fields for Advance Search dialog box.

Searching for a contact
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User Interface Control Description
Available fields List of available fields for a Public Directory that can

be organized using this dialog box. Click a field to
select it.
Click this icon to move a selected field from
Available fields to Show in this order.
Click this icon to move a selected field from Show in
this order .

Show in this order The order of the fields in the Advanced Search
dialog box are displayed according to the order set
here. Click a field to select it.
Click this icon to move the field up in the Show in
this order list.
Click this icon to move the field down in the Show in
this order list.

Save Click to save the settings.

Favorite contacts
Use this feature to add your contacts in Avaya one-X® Communicator as your Favorites. The
Favorite contact feature is available to you with H.323 as well as SIP protocol. To track the presence
status of a contact, you must add a contact as your Favorite. You can add a maximum of 50
contacts as your Favorites. However, you can enhance this limit up to 100 by modifying the
config.xml file. Contact your system administrator to enhance the limit.

Related links
Adding a contact to favorites on page 102
Removing a contact from list of favorites on page 103

Adding a contact to favorites
About this task
Use this procedure to add a contact to your list of favorite contacts. By default Avaya one-X®

Communicator lets you add up to 50 contacts as your Favorites. However, you can increase the limit
to 100 using the config.xml file. Contact your system administrator for increasing the limit to 100.

Procedure
1. Click the Show Contacts icon to display your contacts or search for the contact.

2. Find the contact you want to add to your Favorites.
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3. Right-click the contact and perform any one of the following:

• Select Add to Favorites.

• Select Show Details, select the Favorite check box in the Contact Details dialog box, and
click OK.

Related links
Favorite contacts on page 102

Removing a contact from list of favorites
About this task
When you remove a contact from Favorites, that contact is not deleted from any other directory.
To remove a contact from Favorites, perform the following steps:

Procedure
1. Click the Show Contacts icon to display your contacts.

2. From the View drop-down menu, select Favorites to display your Favorites contact list.

3. Perform one of the following:

• Right-click the contact you want to remove from the Favorites list, and select Show
Details

• In the Contact Details dialog box, clear the Favorite check box and click OK.

OR

• Right-click the contact you want to remove, and select Remove from Favorites.

The contact is removed from your Favorites.

Related links
Favorite contacts on page 102

VIP contacts
The VIP contacts feature is available to you when you integrate Avaya one-X® Communicator with
Avaya one-X® Client Enablement Services. Using this feature you can allow only VIP contacts to call
you when you are busy Avaya one-X® Communicator does not allow any other incoming calls during
this period. For detailed procedure, see:

• Marking a contact as a VIP on page 104.

• Removing a contact from VIP list on page 104.

• Allowing only VIP calls on page 67.

VIP contacts
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Related links
Marking a contact as a VIP on page 104
Removing a contact from VIP list on page 104

Marking a contact as a VIP
About this task
Use this procedure to add a contact to your list of VIP contacts in Avaya one-X® Communicator.

Procedure
1. Click the Show Contacts icon to display your contacts or search for the contact.

2. Find the contact you want to mark as a VIP contact.

3. Right-click the contact and perform any one of the following:

• Select Add to VIP.

• Select Show Details, select the VIP check box in the Contact Details dialog box, and click
OK.

Related links
VIP contacts on page 103

Removing a contact from VIP list
About this task
Use this procedure to remove a contact from your list of VIP contacts in Avaya one-X®

Communicator.

Procedure
1. Click the Show Contacts icon to display your contacts or search for the contact.

2. Find the contact you want to remove from list of VIP contacts.

3. Right-click the contact and perform any one of the following:

• Select Remove from VIP.

• Select Show Details, clear the VIP check box in the Contact Details dialog box, and click
OK.

Related links
VIP contacts on page 103
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Managing contacts group

Creating a group
Use this procedure to create groups for your contacts. You can classify your contacts into different
groups for ease of use.

Procedure
1. Click the Show Contacts icon to display your contacts.

2. Right-click a contact and select New Group.

3. In the New Contacts Group dialog box, enter a name for the group.

4. Click OK.

The new group is created.

Renaming a group
About this task
To rename a group:

Procedure
1. Click the Show Contacts icon to display your contacts.

2. Right-click on the group you want to rename and select Rename Group. In the Rename
Contacts Group dialog box, enter a new name for the group.

3. Click OK.

Deleting a group
Use this procedure to delete a group. When you delete a group, the existing contacts in the group
are moved out to the default group.

Procedure
1. Click the Show Contacts icon to display your contacts.

2. Right-click a group and select Delete Group.

System prompts you with a message Are you sure you want to delete this
group?.

3. Click Yes.

Managing contacts group
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The group is deleted and the contacts from the group are moved to the default group.

Adding a favorite contact to a group
Procedure

1. Click the Show Contacts icon to display your contacts.

2. Find the Favorite contact you want to add to a group.

3. Right-click the contact, move your cursor over the Move into Group and select the group.

The Favorite contact is added to the selected group.

Removing a favorite contact from a group
About this task
To remove a Favorite contact from a group:

Procedure
1. Click the Show Contacts icon to display your contacts.

2. Click the group to expand and view the Favorite contacts in the group.

3. Right-click the Favorite contact you want to remove, and click Remove from Group. The
Favorite contact is removed from the group.

You can view Favorite contact under Other Contacts.

Contact Details dialog box
Contact Details dialog box appears when you double-click a contact to view its details on the
Contacts pane. From the Contact Details dialog box, you can:

• View the presence status of selected Favorite contact.

• View the status message of the selected contact.

• Modify the selected contact details.

• Make a call to the selected contact.

• Send an e-mail to the selected contact.

• Send an instant message to the selected Favorite contact.

• View the video status of the selected contact.

Using Contacts
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Chapter 11: Using Call logs

Viewing call log entries
Avaya one-X® Communicator displays call logs for Incoming, Outgoing, and Missed calls on the user
interface. The maximum number of call logs displayed on the interface is 100. Use the following
procedure to view the call logs.

Note:

If the Call Journaling feature is available on your system, you have consistent view of call logs
whether generated when Avaya one-X® Communicator is logged in, or generated when Avaya
one-X® Communicatoris not logged in.

Procedure
1. Click the Show Call Log icon to open the list of Call Log entries.

2. To view the details of a Call Log entry, right-click the contact and select Show Details.

Next steps
To view the name and number in the Call Log entries, click the Menu icon and select Call Log >
Show Name and Number.
The name and number appear for all the entries in the Call Log.

Sorting call log entries by different parameters
About this task
To sort your Call Log entries by name/number, time, or length of call:

Procedure
1. Click the Show Call Log icon to open the list of Call Log entries.

2. Click on one of the following columns:

• Name/Number
• Time
• Length
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The Call Log entries are displayed in an ascending order depending on the selected
attribute.

To display the Call Log entries in a descending order, click on the column again.

Example

Sorting call log entries by type
About this task
You can sort Call Log entries by type of call (All, Incoming, Outgoing, or Missed).

Procedure
1. Click the Show Call Log icon to open the list of Call Log entries.

2. From the View drop-down menu, select one of the following call log entries types:

• All
• Incoming
• Outgoing
• Missed

Call Indicator Description
Outgoing call

Incoming call

Missed call

Deleting call log entries
About this task
To delete call log entries:

Procedure
1. Click the Show Call Log icon to access the Call Log.

2. Select the call log entries you want to delete.

3. Perform one of the following actions:

• Right-click and select Delete Selected.

Using Call logs
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• Select Settings > Call Log > Delete Selected.

A dialog box prompts you to confirm your action.

4. Click Yes.

Adding a caller to contacts from a call log entry
About this task
If the call log entry is from an unknown number, you can add that entry to your contacts list.
However, in SIP mode, you can only add the contact as a personal contact.

Procedure
1. Click Show Call Log icon to display your call log.

2. Select a contact you want to add to your Contacts.

3. Right-click the Contact and select Add to Contacts.

4. In the Contact Details dialog box, enter contact information as required.

5. Click OK.

Result
The contact is added to your Contacts list.

Note:
If a contact already exists with the same phone number, the system displays the contact details
for that contact.

Call log dialog box
The Call Log dialog box displays information on incoming calls, outgoing calls, and missed calls.
When you make or receive a call, Avaya one-X® Communicator automatically generates a one-line
summary for that call. Avaya one-X® Communicator displays a maximum of 500 call logs in
standalone mode and 200 call logs when integrated with Avaya one-X® Client Enablement Services.
However, your administrator can modify the default settings by:

• Editing the config.xml file in standalone mode. The maximum number of call logs in
standalone mode is 500.

• Modifying the settings in Avaya one-X® Client Enablement Services. The default limit can be
increased up to 400 call logs.

From the Call Log screen, you can:

• View the name of the caller or called party.

Adding a caller to contacts from a call log entry
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• View the presence status of the caller or called party if it already exists in contacts (only if it has
been added as Favorite). You can view the presence status of a contact by the following icons:

Presence State Description
Available

Away

Busy

Do not disturb

Offline or Out of office

On a call

Note:

If a contact status is unknown there is no icon against the contact.

• View the information of the caller or called party if it already exists in contacts.

• View the status message of the caller of the caller or called party if it already exists in contacts.

• View details about an entry.

• View information about the contact who called you or whom you called.

• Add an entry to a Personal contact in SIP mode and also Favorite contact in H.323 mode when
integrated with Avaya one-X® Client Enablement Services.

• Delete the entry.

• Dial the selected number from the entry.

• Send an e-mail to the selected number from the entry.

• Send an instant message to the selected number from the entry (only if it has been added as
Favorite).

• View the video status of the selected number from the entry.

• Sort the entries by type of call (that is, All, Incoming, Outgoing, or Missed), name/number, date/
time, and length of call.

To specify the type of call entries you want to view, select the appropriate call type from the View
drop-down list.

The following icons are used for the Call Log entries:

• Incoming answered call

• Incoming missed call

• Outgoing call

Using Call logs
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Setting Log options
About this task
The Advanced Logging dialog box enables you to set log options for different components. Use the
Set Log Options dialog box to set advanced logging. Log files are generated on the basis of the
severity level assigned to a log component. The technical support team uses logs to find the cause
of the encountered problem.
To set the log options:

Procedure
1. Select a severity level for each of the log components.

2. Click the Log Category button to expand the Log Category.

3. Select the check box for the log category you want to enable. Click Select All to select all
the log categories.

4. Click Export to save the log settings in an .xml file.

5. Click Reset UI Log Files to reset UI Log Files.

6. Click OK to apply the log options.

Diagnostic Logging dialog box
Use Diagnostic Logging to report an issue you are encountering and send the log files to the support
team. The technical support team uses the log files to find the cause of the problem.

About this task
To send the log files to the support team, perform the following steps:

Procedure
1. To enable the diagnostic logging feature, select the Enable Diagnostic Logging check box.

2. Click Send log files now after you encounter a problem or you reproduce a problem that
you have encountered earlier.

As soon as you click this button, your default e-mail client opens. The log files are embedded
in the mail as an attachment.

3. Enter the e-mail id of the support team and fill in the following details in the e-mail:
description of the problem, steps to reproduce the issue, frequency of the problem

4. Click OK in the Diagnostic Logging window to close the window.

Setting Log options
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Chapter 12: Using Instant Messaging and
Presence

Configuring your access control list
Use this feature to allow or deny other users access to your presence status. Avaya one-X®

Communicator lists your Favorite contacts in the Access Control List tab.

About this task
Use this feature to allow or deny a request from other users to view your presence status.

Procedure
1. Click the Menu icon and select Settings > General Settings.

Avaya one-X® Communicator displays the General Settings dialog box.

2. Click IM and Presence.

3. Click Access Control.

Avaya one-X® Communicator displays the list of favorite contacts.

4. Click Allow or Deny to change the setting for a contact.

Sending and receiving instant messages
Avaya one-X® Communicator provides you with the option of sending and receiving messages to
your favorite contacts who are using Avaya one-X® Communicator R6.2.x. If the Avaya one-X®

Communicator application is not in focus, system displays the messages in a toast window at the
bottom right of your desktop. You can chose to view the message or ignore the message. The toast
window displays a maximum of four new message notifications. If you have more than four new
messages, the toast window displays a fifth message notification that aggregates the rest of the
messages.

Avaya one-X® Communicator supports complete view of your conversations even if you are using
multiple endpoints simultaneously. You can view all conversations including your own messages
sent from other endpoints in Avaya one-X® Communicator instant messaging window. When you
leave the conversation from other endpoints, Avaya one-X® Communicator displays a notification
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and disables the controls. You can use a new Avaya one-X® Communicator instant messaging
window to resume the conversation.

About this task
You can use instant messaging in SIP mode as well as in H.323 mode.

Note:
Avaya one-X® Communicator supports unicode enabling to send and receive instant messages
in any language.
You can also send and receive instant messages from Avaya one-X® Agent users if they are
registered on the same presence server or a federated XMPP server.

Procedure
1. Click the Show Contacts icon to display your contacts.

2. From the View drop-down menu, select Favorites to display your Favorites contact list.

Avaya one-X® Communicator displays the Launch IM icon in the following ways depending
on availability:

• If a contact is not added as a Favorite contact, Avaya one-X® Communicator considers the
contact as offline and displays an empty Launch IM icon.

• If your Favorite contact is available, Avaya one-X® Communicator displays the Launch IM
icon.

• If your Favorite contact is not available on Avaya one-X® Communicator but is available on
other devices, system displays the Launch IM icon with a cross mark.

3. Click the Launch IM icon for the contact to which you want to send instant messages.

The Instant Messaging dialog box appears.

4. Enter your message. You can enter a maximum of 500 characters in an instant message.

5. Click Send to send a message to the contact.

Next steps
Note:
If the contact is offline, message <Contact_name> is currently offline. Messages
sent to offline users will be delivered when they come online. appears in
the Instant Messaging window.

Inserting emoticons in an instant message
While entering an instant message in the Instant Messaging window, you can also add emoticons.

About this task
To insert an emoticon in an instant message:

Inserting emoticons in an instant message
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Procedure
1. Click the Contacts icon to display your contacts.

2. From the View drop-down menu, select Favorites to display your Favorites list.

3. Click the Launch IM icon for the contact to which you want to send instant messages.

The Instant Messaging window appears.

4. Enter your message.

5. Click the Send Emoticon button to open the emoticons list.

6. In the emoticons list, select an emoticon.

The emoticon is added in the instant message.

Changing your presence status
About this task
You can set your IM Presence status from Avaya one-X® Communicator. To change your presence
status:

Procedure
1. Click the Presence status icon (located next to your display name).

The list of Presence status icons appears.

2. Select the appropriate Presence status.

Your choices are:

• Automatic

When you select this presence state, Avaya one-X® Communicator automatically changes
your presence according to your current status. For example, if you make or answer a call,
your presence status automatically changes to On a call.

• Available

• Away

• Busy

• Do not disturb

• Out of office

• Offline

Using Instant Messaging and Presence

November 2015 Using Avaya one-X® Communicator 114
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya one-X® Communicator


Note:

If you set the presence status manually, “Away” note will be published anyway after Tn
timer expires. (Tn timer is a timer configured using the check box “Set Away when I’ve
been inactive for ... minutes” on the IM and Presence screen).

Changing the fonts of an instant message
About this task
While entering an instant message, you can also change the fonts.

Procedure
1. Click Show Contacts to display your contacts.

2. From the View drop-down menu, select Favorites to display your Favorites list.

3. Click Launch IM button for the contact to which you want to send instant messages.

The Instant Messaging window appears.

4. Click the Change Font Settings icon to display a font selection window.

5. Select a font, style, color, and size.

6. Click Save.

7. Enter your message.

The instant message appears in the new font.

Sending files through an Instant Message window
About this task
Apart from exchanging messages through the instant messaging window, you can also transfer files
securely to your favorite contacts. However, you can send files to your favorite contacts who are
using Avaya one-X® Communicator Release 6.2.6 or later versions and not any other interoperable
soft clients including third-party products. Avaya one-X® Communicator encrypts the files while
sending and decrypts the files while receiving. The file transfer feature is disabled by default.
Contact your system administrator to enable the feature.

Note:
Avaya one-X® Communicator does not support sending and receiving of files if you use an SBC
server remote connection to connect to your Avaya Aura® system.

Procedure
1. Click the Show Contacts icon to display your contacts.

Changing the fonts of an instant message
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2. From the View drop-down menu, select Favorites to display your Favorites list.

3. Click the Launch IM icon for the contact to which you want to send instant messages.

The Instant Messaging window appears.

4. Click the Send attachment icon to send a file.

The Send attachment icon appears only if the file transfer feature is enabled. The feature is
disabled by default. Contact your administrator to enable the file transfer feature.

5. In the Select Files to send dialog box, browse to the file location, select the file, and click
Open.

The selected file is displayed in the message text box of the sender and receiver.

Note:

You can send any type of file with a maximum size of 4-GB. The option to receive a file
closes if the receiver does not receive the file within five minutes.

Receiving files through an instant message window
Avaya one-X® Communicator R6.2.6 and later versions decrypt the secured files when you opt to
download the file from the instant messaging window.

About this task
You can use the Instant Messaging window to receive and save files from your Contacts.

Note:
Sending and receiving files is not supported if you use an SBC server remote connection to your
Avaya Aura® system.

Procedure
1. In the Instant Messaging window, click Save as to save a file.

Note:

You can receive any type of file with a maximum size of the file you can receive is 4 GB.
The option to receive a file closes if the receiver does not receive the file within five
minutes.

2. In the Save a file dialog box, browse to the location where you want to save the file and click
Save.

Using Instant Messaging and Presence

November 2015 Using Avaya one-X® Communicator 116
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya one-X® Communicator


Making a call from the instant messaging window
Apart from using the instant messaging window to send and receive messages, you can also call
the contact from the window.

Procedure
1. Click the Show Contacts icon to display your contacts.

2. From the View drop-down menu, select Favorites to display your Favorites list.

3. Click the Launch IM icon to view the Instant Messaging window.

4. Click the Call icon at the top of the Instant Messaging window.

Sending instant messages while on an active call
About this task
While on a call with a contact, you can also send instant messages to the contact.

Procedure
1. Click the Show Contacts icon to display your contacts.

2. From the View, select Favorites to display your Favorites list.

3. Click the Dial button to initiate a call.

A call appearance is displayed

4. Click the Launch IM icon to view the Instant Messaging window.

5. Click Send to send your message to the contact.

Sending and receiving instant messages from call logs
About this task
To send and receive instant messages from Call Log:

Procedure
1. Click the Show Call Log icon to access the Call Log.

2. Perform one of the following:

• Double-click an entry for which you want to send instant messages, and click the Launch
IM icon in the Call Details window.

• OR Click the Launch IM icon in the Call Log for the selected contact

Making a call from the instant messaging window
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The Call Details window appears.

3. Enter the message and click Send to send it to the contact.

IM and Presence - Access Control List tab
Use the Access Control List tab on your IM and Presence screen to allow or deny access to your
Presence status for the listed users.

Setting Description
Allow Selecting this option from the drop-down menu

enables the user to access your Presence status.
Deny Selecting this option from the drop-down menu

denies the user to access your Presence status.

IM and Presence - Preferences tab
Specify your preferences for Instant Messaging and Presence use according to the settings
description below.

Setting Description
Set Away when I’ve been inactive for ... minutes Select the check box if you want the presence status

to be changed to Away when you are inactive for a
certain period of time (The default value is 10
minutes). You can set the value from 5 to 100
minutes.

Activate the "Send all calls” feature (if available)
when presence is set to ”Do not disturb”

Select the check box if you want to activate the
"Send all calls” feature when presence is set to ”Do
not disturb”. The check box is available for selection
only if the feature has been activated using the
Centralized Administration Tool.

Enable dialable number parsing in message text Select the check box if you want the dialable number
to be parsed in the message text.

Enable hyperlink parsing in messaging text Select the check box if you want the hyperlink to be
parsed in the message text.

Store Instant Message history for the last _ days Select the number of days from the drop-down menu
to store instant messages.

Open History Folder Click to view the instant messages history folder.

Using Instant Messaging and Presence
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Chapter 13: Using Voice Messaging

Configuring Avaya one-X® Communicator to access a
messaging system

About this task
If you are using Avaya one-X® Client Enablement Services integration, and visual voice mail is
administered for your Client Enablement Services account, you do not have to configure Avaya one-
X® Communicator to access the messaging system. In this case, Avaya one-X® Communicator is
already configured to access your visual voice mail messages on page 120.
When you receive a voice mail message, the Message Waiting Indicator (MWI) icon, located in the
top-left corner of the Avaya one-X® Communicator main window, is turned "on," indicating that you
have one or more voice mail message. You can access your messaging system from Avaya one-X®

Communicator by clicking on the Message Waiting Indicator icon. However, you must first configure
Avaya one-X® Communicator to access your messaging system. If you click on the Message
Waiting Indicator icon before configuring Avaya one-X® Communicator to access your messaging
system, no action occurs (that is, Avaya one-X® Communicator does not access your messaging
system).
You can set Avaya one-X® Communicatorto access your messaging system in one of the following
ways:

• Dial the access number of the messaging system.
• Open an application that accesses the messaging system.
• Open a Web browser and go to the Web page for the voice messaging system.

To configure Avaya one-X® Communicator to access your messaging system:

Procedure
1. Click theMenu icon and select Settings > General Settings.

The General Settings dialog box appears.

2. Click Messaging.

The Messaging page appears.

3. Select the Enable Message Access check box.
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4. Perform one of the following:

• If you want Avaya one-X® Communicator to dial a telephone number:

a. Select the Dial this number option.

Note:

You can also use Auto-configure to configure this number.

b. In the text box, enter the telephone number you want to dial to access the messaging
system.

c. Go to Step 5.

• If you want Avaya one-X® Communicator to open another application to access the
messaging system:

a. Select the Start This Application option.

b. Using the Browse icon, select the application you want to run.

c. Go to Step 5.

• If you want Avaya one-X® Communicator to open a Web browser to access the Web page
for the messaging system:

a. Select the Open Webpage option.

b. In the text box, enter the Web page for the messaging system.

c. Go to Step 5.

5. Click OK to close the General Settings dialog box.

Accessing the voice messaging system
About this task
If you are using Avaya one-X® Client Enablement Services integration, and visual voice mail is
administered for your Client Enablement Services account, go to Accessing your visual voice mail
messages on page 122.
When you receive a voice mail message, the Message Waiting Indicator on your telephone is turned
"on". When this occurs, the Voice Messages Status icon turns on in the Avaya one-X®

Communicator window. You can access your voice messaging system from Avaya one-X®

Communicator by clicking on the Voice Message Status icon. However, you must first configure
Avaya one-X® Communicator to access your voice messaging system. If you click the Voice
Messages Status icon before configuring Avaya one-X® Communicator to access your voice
messaging system, no action occurs (that is, Avaya one-X® Communicator does not access your
voice messaging system).

Using Voice Messaging
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Procedure
Click the Voice Messages Status icon located at the top-left corner of the Avaya one-X®

Communicator main window. Avaya one-X® Communicator attempts to contact your voice
messaging system.

Message Details Dialog Box
Use the Message Details dialog box to view the date, time, sender, and subject for the selected
message, and to listen to/view the selected message and its attachment(s) (if available).

Field Description
Voice Enables you to play, pause, and stop the voice

message.
Text Displays the text message.
Attachments Enables you to open and save the selected

attachment(s).

Message Details Dialog Box
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Chapter 14: Using Visual Voice Mail

Accessing your visual voice mail messages
About this task
If you are using Avaya one-X® Client Enablement Services, you can access your Visual Voice Mail
messages.

Procedure
1. Click the Show Messages icon.

Your list of messages appears. From the messages screen, you can:

• Listen to/view your messages

• Save your message attachment s to a file

• Mark your messages as "unread"

• Sort the messages by type of message (that is, All, Read, or Unread)

• Name/number, and date/time

2. To listen to a voice mail message, do either of the following:

• Right-click a message and select Listen;

• Double click an entry.

The Message (Voice) window appears.

In the Voice area, use the controls to play the message.

3. Click the Menu button and select Save to save the message at a location of your choice.

4. Click the Menu button and select Open to play the message in another media player.

Example

Note:
If you double-click a message, it starts playing as soon as the download completes. You do not
need to click to play it.

Marking a message as Unread
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About this task
To mark a visual voice mail message as Unread:

Procedure
1. Click the Show Messages icon.

Your list of messages appears.

2. Right-click the selected entry you want to mark as Unread, and then select Mark as Unread.

Deleting a visual voice mail message
About this task
To delete a visual voice mail message:

Procedure
1. Click the Show Messages icon.

Your list of messages appears.

2. Right-click the message you want to delete, and then select Delete.

The selected message is deleted.

Making a call from a visual voice mail Message
About this task
To make a call from a visual voice mail message:

Procedure
1. Click the Messages icon to display your voice mail messages.

2. Select a number you want to call.

3. Perform one of the following:

• Click the Call icon for the entry you want to call.

• Right-click the entry and select Contact  > Call.

Note:

The Call icon appears only when the voice mail includes a telephone number

Deleting a visual voice mail message
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Adding a number to contacts from visual voice mail
messages

About this task
Besides adding a personal contact, you can add a Favorite contact if Avaya one-X® Communicator
is able to resolve the contact name.

Procedure
1. Click the Show Messages icon to display your voice mail messages.

2. Select an entry you want to add to your contacts list.

3. Right-click the entry, and select Add > Favorites.

Result
The contact is added to contacts list.

Note:
If a contact already exists with the same phone number, the system displays the contact details
for that contact.

Sending an e-mail to a contact from a visual voice mail
message

About this task
This feature is available only when Avaya one-X® Communicator is integrated with Avaya one-X®

Client Enablement Services. Also, you can send an e-mail to a contact only when the contact is
added on the Client Enablement Services.
To send an e-mail to a contact from a Visual Voice Mail message, run the following actions::

Procedure
1. Click the Show Messages icon to display your voice mail messages.

2. Perform one of the following:

• Click the Send Email icon adjacent to a contact you want to send an email.

• Right-click the contact and select Contact > Send Email.

This displays your default mail client (Microsoft Outlook or IBM Lotus Notes) to compose a
new e-mail.

Using Visual Voice Mail
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Sending an IM to a contact from a visual voice mail
message

About this task
Note:
This feature is available when Avaya one-X® Communicator is integrated with Avaya one-X®

Client Enablement Services. You can send an instant message only if the contact is added to
the Avaya one-X® Client Enablement Services server.

To send an instant message to a contact from a visual voice mail message:

Procedure
1. Click the Show Messages icon to display your voice mail messages.

2. Perform one of the following:

• Click the Launch IM icon adjacent to a contact you want to send an instant message

• Right-click the contact, and select Contact > Launch IM.

3. Type your message and click Send.

Messages
The Messages pane displays your Visual Voice Mail messages. From the Messages window, you
can:

• listen and view your messages

• save your message attachments to a file

• mark your messages as unread

• sort the messages by type of message (that is, All, Read, or Unread)

• name/number, and date/time

Sending an IM to a contact from a visual voice mail message
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